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Introduction
This Release Notes document summarizes the features, enhancements, and updates delivered with 
FlexNet Operations 2025.05 in May 2025. The document includes the following information:

• Resources

• Features and Enhancements

• System Requirements

• Resolved Issues

• Known Issues

• Special Notes

• SOAP API Change Log

• Legal Information

Resources
These resources are available for more information about FlexNet Operations and other Revenera 
products:

• Revenera Resources

• FlexNet Operations Videos

• Previous FlexNet Operations Release Notes

Revenera Resources
The following resources can help you stay up to date with FlexNet Operations news and product 
knowledge:

• In addition to providing case management, the Revenera Community site can help you quickly find 
answers to your questions by searching content from other customers, product experts, and 
thought leaders. You can also post questions on discussion forums for experts to answer. For 
each of Revenera’s product solutions, you can access forums, blog posts, and knowledge base 
articles. You can also access the Product and License Center from the Community’s Other 
Resources menu to download Revenera products.

• You can find documentation for FlexNet Operations and all other Revenera products on the 
Revenera Product Documentation site.

Note that any FlexNet Operations documentation published for UAT is subject to finalization until 
the Production release.

• The Revenera Learning Center offers free, self-guided, online videos to help you quickly get the 
most out of your Revenera products. You can find a complete list of these training videos in the 
Learning Center. 

https://community.revenera.com
https://docs.revenera.com
https://learning.revenera.com
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• Customers who have purchased a maintenance contract for their product(s) can submit a support 
case or check the status of an existing case by first logging into the Revenera Community, clicking 
Support on the navigation menu to open the Support Hub page, and then clicking the Open New 
Case or Case Portal button.

FlexNet Operations Videos
These brief, informative videos walk you through the getting-started exercises found in the FlexNet 
Operations User Guide (online help or PDF version). We recommend that you first read the appropriate 
“Getting Started” section in the User Guide to gain an understanding of the concepts it covers, and 
then click the section title in the table below to view the video.  

Previous FlexNet Operations Release Notes
To view the release notes associated with FlexNet Operations ALM releases from previous years, 
access https://docs.revenera.com/?product=FlexNet%20Operations and select the appropriate year 
from the VERSION list.

Guide Topics

Getting Started with 
Entitlement Management

Creating an account, a user, a product, and an entitlement. 

Getting Started with FlexNet 
Embedded Licensing

Setting up a publisher, identity, and a licensed product. Creating a 
device and activating its license. Creating and provisioning FlexNet 
Embedded license servers. 

Getting Started with 
Electronic Software Delivery

Creating a producer and download packages, associating 
download packages with a product, creating files, associating files 
with download packages, and viewing and downloading files from 
the FlexNet Operations End-User Portal. 

Getting Started with Usage 
Management

Creating a usage-based license model, a feature, a product, and an 
entitlement. Obtaining the license server URL to which the usage 
data is sent. Running a usage-capture client. Viewing usage 
information graphs and gauges.

Getting Started with FlexNet 
Publisher License File-Based 
Licensing

Activating and returning a certificate license.

Getting Started with Cloud 
Licensing Service

Creating a cloud-hosted license server. 

Getting Started with FlexNet 
Customer Growth

Customer growth concepts and configuring notifications for 
expiring entitlements and expired entitlements. 

https://youtu.be/L_DJynsiCRs
https://youtu.be/6-juN9F9OBo
https://www.youtube.com/watch?v=VGnH8dFj_bE
https://youtu.be/1rPRl-NKgJY
https://youtu.be/-OHqqD62fyk
https://www.youtube.com/watch?v=MNX5bgFHPVg
https://youtu.be/u0oCCN-iXJU
https://docs.revenera.com/?product=FlexNet%20Operations
https://community.revenera.com
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Features and Enhancements
The following sections describe the new features and enhancements added to FlexNet Operations in 
2025:

• Features and Enhancements in 2025.05

• Features and Enhancements in 2025.04

• Features and Enhancements in 2025.03

• Features and Enhancements in 2025.02

• Features and Enhancements in 2025.01

Features and Enhancements in 2025.05
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.05 
release:

• Device Management Enhancements in 2025.05

• Entitlement Management Enhancements in 2025.05

• SOAP and REST Web Services Enhancements in 2025.05

• User Experience Enhancements in 2025.05

Device Management Enhancements in 2025.05
The following enhancements to device management were added in the 2025.05 release.

• Device History Now Listing Users Who Triggered Events

• Bulk Updating Account Information for Devices

Device History Now Listing Users Who Triggered Events 
(Cases 02685529, 02869243; SWM-13895)

The Device History page (available by clicking View > View Device History on a Device or View Server 
page) now includes a User Details column, which lists the name of the user who triggered an event (for 
example, creating a device or mapping entitlements). 
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 This improvement enhances transparency by identifying who performed particular actions on a 
device, making it easier to troubleshoot issues. 

Figure 1: Example of the Device History page with the User Details column.

Bulk Updating Account Information for Devices
(SWM-25969) 

Producers can now use the newly introduced Devices Template to assign an account to multiple 
devices at a time. This offers an easier and faster UI-based way to perform bulk transfers of 
entitlements between accounts, including stock returns and the transfer of faulty appliance 
entitlements.

To download the Devices Template (XLSX format), click Administer > Import Data Objects and select 
the Data Import Templates tab.
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Figure 2: The Devices Template can be downloaded from the Import Data Objects page.

In the template, the following properties must be provided to update account information for devices: 
host id, publisher name, host class, host id type and account ID. 

This screenshot shows an example of a populated template:

Figure 3: Example of a populated XLSX template.

Once the Devices Template has been populated, it must be saved as a Unicode .txt file before it can be 
imported into FlexNet Operations, using the Import Settings tab on the Import Data Objects page.



FlexNet Operations 2025.05 ALM Release Notes (UAT)  (May 2025)  8

Entitlement Management Enhancements in 2025.05
The following enhancements to entitlement management were added in the 2025.05 release.

• Ability to Limit Activation of FlexNet Embedded Nodelocked Licenses to Servers and/or 
Standalone Devices

• CONTAINER_ID Host ID Now Available for Docker Containers

• Merge Tags Added to Fulfillment On Hold Email Template to Improve Communication

Ability to Limit Activation of FlexNet Embedded Nodelocked Licenses to 
Servers and/or Standalone Devices 
(SWM-19823, SWM-24434)

Producers can now specify whether a nodelocked FlexNet Embedded license can only be activated on 
license servers, standalone devices, or both. This enhancement increases a producer’s control over 
license activation, and prevents license leakage caused by uncounted licenses being activated on a 
license server. 

Controlling the activation of FlexNet Embedded licenses is done during license model creation 
(Administer > License Models > Create new license model). When selecting the license model type 
Embedded, producers can select where the license model can be activated using the new option, 
Hosted On. The following options are available:

• License Servers—Licenses can only be activated on license servers. Attempts to activate a license 
on a standalone device will fail.

• Standalone Devices—Licenses can only be activated on standalone devices. Attempts to activate 
a license on a license server will fail.

• Both—Licenses can be activated on license servers and on standalone devices. This is the default 
option.
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Figure 4: The Hosted On property is set during license model creation.

The above controls apply to online and offline activations and are enforced regardless of activation 
type (Producer Portal, Web services, capability requests).

Behavior when changing a license model for a product

To explain the behavior, consider that you have the following license models defined: 

• License model 1: HostedOnServerOnly, Hosted On property set to License Servers

• License model 2: HostedOnStandalone, Hosted On property set to Standalone

When the license model of an existing product is changed—for example, the license model is changed 
from HostedOnServerOnly to HostedOnStandalone—FlexNet Operations will correctly validate license 
applicability based on device type.

While the entitlement line items are not removed automatically, once the license model is changed, 
licenses with HostedOnStandalone are no longer shown for Cloud License Server (CLS) instances or 
local license servers. Users must manually remove entitlements if they are no longer valid for the 
device.
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This behavior ensures that licenses meant only for standalone devices won't mistakenly appear for 
license servers, reducing confusion and helping enforce correct usage.

CONTAINER_ID Host ID Now Available for Docker Containers
(Case 02758504, SWM-19930)

The list of hostid types available for Flexnet Publisher certificate-based licensing now also includes the 
host ID type CONTAINER_ID. The CONTAINER_ID is used to node-locking a license server and feature 
licenses to a docker container host ID. 

Figure 5: The CONTAINER_ID can be selected in the Create License Host window.

Producers wanting to use CONTAINER_ID as a host ID must build a new version of the Vendor Certificate 
Generator (VCG) executable and need to change the generator configuration to version 16.2.3.0. 
Instructions on how to build a new version can be found in the Flexnet Operations User Guide, topic 
Creating a FlexNet Publisher Licensing Toolkit License Generator (VCG) Configuration.

Merge Tags Added to Fulfillment On Hold Email Template to Improve 
Communication
(SWM-25684)

When an on-hold fulfillment is created, an email can be triggered to notify the producer that the 
fulfillment is waiting for a license to be set. The Fulfillment On Hold template, on which such an email 
would be based, has now been enhanced to include additional merge tags to include relevant details. 
(Previously, the only merge tag available in this template was [[FulfillmentID]].)

https://docs.revenera.com/fno_CURRENT/producer/Content/helplibrary/opsCreateVcgConfig.htm
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List of Merge Tags in Fulfillment On Hold Template

The following table lists all merge tags currently available in the Fulfillment On Hold template. 

Sample Code for Fulfillment On Hold Template

This sample shows how the merge tags could be used in the Fulfillment On Hold template.  

Merge Tag Description Example Preview Value

[Acctld]] Account ID ACME

[[AcctName]] Account Name MYORG

[ACTIVATION_DATE]] Activation Date Feb 28, 2007

[[ActivationID]] Activation ID 9e8f-8b6f-0fbf-4488-950b-
e4a5-1bfe-e73c

[[EntitlementID]] Entitlement ID bf1a-1191-4957-46aa-4f7f-fe

[[EXPIRATION_DATE]] Order Line - Last day that 
the object is effective 
(exclusive)

2/1/2003

[[FulfillmentCount]] Fulfillment Count < FulfillmentCount >

[[FulfillmentID]] Fulfillment ID < FulfillmentID >

[[LICENSE_MODEL_ATTRIBUTES]] License Model Attributes < LICENSE_MODEL_ATTRIBUTES >

[[LICENSE_MODEL_NAME]] License Model Name < LICENSE_MODEL_NAME >

[[LicenseTechnology]] License Technology FlexNet Licensing

[[OverdraftCount]] Overdraft Count < OverdraftCount >

[[PartnerTierName]] Partner Tier Name End Customer

[[PartNumber]] Part Number PartNumberOne

[[PRODUCT_NAME]] Product Name Test Product

[[PRODUCT_VERSION]] Product Version 7.6

[[ShipToAddress]] Ship To Address < ShipToAddress >

[[ShipToEmail]] Ship To Email < ShipToEmail >

[[START_DATE]] Start Date < START_DATE >
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License text has not been set for the following generated fulfillment. The administrator was 
notified. You will receive an email when the license is ready to download. <br/>
------------------------------------------------------------------------------<br/>
Fulfillment On Hold<br/>
------------------------------------------------------------------------------<br/>
FulfillmentID = <b>[[FulfillmentID]]</b><br />
Activation ID: [[ActivationID]]<br />
Entitlement ID: [[EntitlementID]]<br />
------------------------------------------------------------------------------<br/>
Sold to AccountName:  [[AcctName]]<br />      
Sold to AccountID:  [[AcctID]] <br/>
ChannelPartnerDetails: <br/>
[[PartnerTierName]]: <br /> 
------------------------------------------------------------------------------<br/>
ProductName:  [[PRODUCT_NAME]] <br/>       
ProductVersion: [[PRODUCT_VERSION]] <br/>
PartNumber: [[PartNumber]] <br/>
LicenseTechnology: [[LicenseTechnology]] <br/>
LicenseModel: [[LICENSE_MODEL_NAME]] <br/> 
------------------------------------------------------------------------------<br/>
LicenseModelAttributes: <br/>
[[LICENSE_MODEL_ATTRIBUTES]] <br/>
------------------------------------------------------------------------------<br/>
StartDate: [[START_DATE]] <br/>
ExpirationDate: [[EXPIRATION_DATE]] <br/>
FulfillmentDate: [[ACTIVATION_DATE]] <br/>
------------------------------------------------------------------------------<br/>
OverdraftCount :[[OverdraftCount]] <br/>
FulfillmentCount : [[FulfillmentCount]] <br/>
------------------------------------------------------------------------------<br/>

Sample Email Based on the Fulfillment On Hold Template

The code above would result in an email similar to the following:
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Figure 6: Example of an email with detailed fulfillment information, based on the Fulfillment On Hold 
template. 

SOAP and REST Web Services Enhancements in 2025.05
The following enhancement was added to the SOAP and REST Web Services module in the 2025.05 
release.

Zero Mapping of Activation IDs on Cloud License Servers 
(SWM-25022) 

The 2025.05 release introduces version 7 of the ManageDevice SOAP web service. The new version 
contains a new operation, zeroCountAddonLineItems, which enables producers to explicitly set an 
activation ID with a zero allocation mapping on a Cloud License Server (CLS) instance. 

This enhancement enables customers to clearly distinguish between activation IDs that are fully 
entitled for allocation (full count) and those that are restricted for allocation on the CLS.
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Previously, when querying activation IDs via SOAP services like searchDevices, there was no easy way 
to identify activation IDs that were intentionally restricted from allocation. Such activation IDs simply 
did not appear, making it difficult for customers to differentiate between no mapping and full 
allocation from the master entitlement.

By explicitly creating a zero allocation mapping, producers can track and manage entitlement behavior 
accurately, improving license compliance and allocation control across their deployments.

Notes for Using zeroCountAddonLineItems

• The configuration option Allow mapping zero counts to FlexNet Embedded devices (under System 
> Configure > FlexNet Operations > Embedded Device Settings) must be selected.

• Values submitted in the web request are not validated. As long as the request contains a valid 
device ID and line item details, the relevant mapping will be updated.

• No validation takes place. Whatever mapping line item customer provides is mapped to a 
particular device, regardless of e.g. whether the license model is supported. 

• Information related to calling the zeroCountAddonLineItems operation will be tracked and can be 
reviewed on the Search Transactions page in the Producer Portal (under System > Transaction 
History).

Example Request for zeroCountAddonLineItems

The sample code, below, shows a request to allocate zero counts from activation ID 83a2-9824-c72b-
488t-bbde-9bbb-fce3-1344 to the device with ID devicel_type.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
<soapenv:Header/>
<soapenv:Body>
<urn:zeroCountAddonLineItemsRequest>
<!-- 1 or more repetitions: -->
<urn:requestList>
<urn:deviceIdentifier>
<urn:deviceType>SERVER</urn:deviceType>
<!-- Optional: -->
<urn:deviceId>devicel_type</urn:deviceId>
<!-- Optional: -->
<urn:serverIds>
<!-- 1 or more repetitions -->
<urn:serverId>device1_type</urn:serverId>

</urn:serverIds>
<!-- Optional: -->
<urn:deviceIdType>ETHERNET</urn:deviceIdType>
<!-- Optional: -->
<urn:publisherName>FLEXERA</urn:publisherName>

</urn:deviceIdentifier>
<!-- 1 or more repetitions: -->
<urn:lineItem>
<urn:lineItemIdentifier>
<!-- Optional: -->
<urn:activationId>83a2-9824-c72b-488t-bbde-9bbb-fce3-1344</urn:activationId>
<!-- Optional: -->
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<urn:count>0</urn:count>
<!-- Optional: -->

</urn:lineItemIdentifier>
</urn:lineItem>

</urn:requestList>
</urn:zeroCountAddonLineItemsRequest>

</soapenv:Body>
</soapenv:Envelope>

Example Response for zeroCountAddonLineItems

The sample code, below, shows a response for a successful request.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
soapenv:Body
<zeroCountAddonLineItemsResponse xmlns="urn:v7.fne.webservices.operations.flexnet.com">
<statusInfo>
<status>SUCCESS</status>

</statusInfo>
<responseData>
<deviceIdentifier>
<deviceType>SERVER</deviceType>
<deviceId>device1_type</deviceId>
<serverIds>
<serverId>device1_type</serverId>

</serverIds>
<deviceIdType>ETHERNET</deviceIdType>
<publisherName>FLEXERA</publisherName>

</deviceIdentifier>
</responseData>

</zeroCountAddonLineItemsResponse>
</soapenv:Body>

</soapenv:Envelope>

User Experience Enhancements in 2025.05
The following user experience enhancement was added in the 2025.05 release.

• Additional Web Service Transactions Visible in Producer Portal

• Selecting Individual Line Items in Entitlement Notification Email

Additional Web Service Transactions Visible in Producer Portal
(SWM-24811, SWM-24812, SWM-24813, SWM-24817, SWM-24818) 

The 2025.04 release introduced a number of enhancements that increase transparency into 
transactions performed on a device—whether initiated via web services or in the Producer Portal or 
End-User Portal. Such transactions are displayed on the Search Transactions page in the Producer 
Portal (under System > Transaction History). 

In the 2025.05, the following additional webservice-based actions are now captured on the Search 
Transactions page: 
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• Deleting line items from a device

• Obsoleting a host

• Removing add-on line items from a device

• Move device from one account to another

• Deleting a device

Tracked Operations In 2025.05

Transactions are tracked for standalone devices, Cloud License Server instances and local license 
servers. The following table lists the operations of the ManageDeviceService web service that are now 
tracked: 

Transaction Web Service Operation Event Type Description

Transactions tracked from release 2025.05 onwards

Deleting a line item 
from a device

deleteAddOnLineItemsReq
uest

UPDATE Tracks transactions where an 
entitlement line item was deleted 
on a device. 

Obsoleting the 
host for a device 

obsoleteHostRequest DELETE Tracks transactions where a host 
for a device was deleted.

Removing add-on 
line items

decrementAddonLineItems
Request

UPDATE Tracks transactions where an add-
on line item was removed from a 
device. 

Moving a device to 
a different account

moveDeviceRequest UPDATE Tracks transactions where a device 
is moved to a different account. 

Deleting a device deleteDeviceRequest DELETE Tracks transactions where a device 
is deleted. 

Transactions tracked from release 2025.04 onwards

Creating a device createDeviceRequest CREATE Tracks all successful and failed 
attempts to create a device. 

Linking 
entitlement line 
items to a device

linkAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was linked to 
a device, or where a metered 
license was removed from a 
device. 

Incrementing 
entitlement line 
items to devices

IncrementAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was 
incremented on a device. 
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For a use case example or information about how to view transaction details, see Improved 
Transaction Visibility in Producer Portal.

Selecting Individual Line Items in Entitlement Notification Email 
(Case 02971350, SWM-24682)

On the List Entitlement By Orders page, producers can now select individual line items to be included 
in the entitlement notification email, instead of including all line items in the email. This is useful in 
scenarios where only some of an entitlement’s line items have been added or updated. 

To include only certain line items from an entitlement, a producer needs to select the desired line 
items on the List Entitlement By Orders page and click the Email button, as shown in this screenshot:

The next screen will show the entitlement notification email, which only contains the selected line 
item. The notification email might look like this: 

Updating a device updateDevice UPDATE Tracks transactions where a device 
was updated.

Transaction Web Service Operation Event Type Description
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Previously, if an entitlement contained more than one line item, the entitlement notification email 
would always include all of the entitlement’s line items.

Features and Enhancements in 2025.04
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.04 
release:

• Entitlement Management Enhancements in 2025.04

• User Experience Enhancements in 2025.04

• SOAP and REST Web Services Enhancements in 2025.04

Entitlement Management Enhancements in 2025.04
The following enhancements to entitlement management were added in the 2025.04 release.

• Allow Renewal License to Start Upon Expiry of Parent License

• Grouping Product Information in Entitlements Email Template

• New “Features” Column on List Entitlements Page

Allow Renewal License to Start Upon Expiry of Parent License
(Case 02679546; SWM-21239) 
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Currently, mapping a renewal license to a device can result in the parent license being unmapped, 
temporarily leaving the device without a license. 

This issue occurs when a renewal relation is set up between the parent and the child line items, and 
the renewed (child) line item has a future start date. When the renewed line is activated, it replaces the 
parent line mapped to the device. It is possible to create a renewal line item without linking to the 
parent line item; in this case there is no gap in license coverage. 

To address this issue, the 2025.04 release introduces a configuration which allows producers to 
change the behavior when mapping renewal licenses to devices. The new configuration called Retain 
mapping of the parent activation to the devices when mapping a child activation is available under 
System > Configure > Embedded Devices > Host Options. By default, the option is unselected, 
maintaining the behavior of previous releases.

When this option is selected, the parent license remains mapped to the device even when a child 
license (for a renewal, upgrade or upsell) is applied. This means that the parent license continues to be 
available after the child line item has been mapped. 

This enhancement allows producers to issue renewal licenses well before the parent license expires, 
and it enables customers to apply the renewal license early. This ensures uninterrupted license 
coverage throughout the device's activation lifecycle, preventing any interruptions.

There has been no change to the user experience. Activations are mapped as before: 

• Producer Portal—On the View Device or View Server page (under Devices > Devices, click a 
hyperlinked device name), click Licenses > Map Entitlements or Map by Activation IDs.

• SOAP web services—Using the the incrementAddonLineItems and linkAddonLineItems operations 
of the ManageDeviceService web service.

Note • Producers are responsible for explicitly unmapping unused/expired activations.

Grouping Product Information in Entitlements Email Template 
(Cases 02749254, 02956269; SWM-21546)

This release introduces a new merge tag [[FOR-EACH tag="EntitledProductLine"]] for the 
Entitlement email template. This tag can be used to group all the products from a product line along 
with information about each product in the Entitlement email that customers will receive. 

Use of the new merge tag is controlled by the configuration option Allow grouping of product 
information based on product line in entitlement email template (under System > Configure > FlexNet 
Operations > General Options). By default, this option is disabled.

This enhancement gives producers more flexibility when structuring their entitlement emails. 
Depending on whether the configuration option is selected or unselected, the Entitlement email can 
either:

• iterate the product line and print product information, or

• iterate the product and print product line information. 

The following examples illustrate the different Entitlement emails that can be generated:

• Configuration Option Selected, Iterating Product Lines
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• Configuration Option Unselected, Iterating Products

Configuration Option Selected, Iterating Product Lines  

The following example code shows how to use the merge tag [[FOR-EACH 
tag="EntitledProductLine"]] to iterate through product lines and then iterate the products for each 
product line, along with sample output.

[[FOR-EACH TAG="Entitlement" child-only="true"]]
[[FOR-EACH TAG="EntitlementLineItem"]]

[[IF TAG="LicenseGenerator" VALUE="demo"]]
[[FOR-EACH tag="EntitledProductLine"]]

Product Line - [[ProductLine]]
[[FOR-EACH tag="EntitledProduct"]]

Product Name: [[Name]]
Product Description: [[Description]]

[[END FOR-EACH]]
[[END FOR-EACH]]

Part Number: [[PartNumber]]
Permanent: [[Permanent]]
Start Date: [[StartDate]]
Expiry Date: [[ExpirationDate]]
ActivationID: [[ActivationID]]

[[END IF]]
[[END FOR-EACH]]

[[END FOR-EACH]]

A resulting Entitlement email might look like this:

Figure 7: Entitlement email using the [[FOR-EACH tag="EntitledProductLine"]] merge tag
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Configuration Option Unselected, Iterating Products

When the configuration option Allow grouping of product information based on product line in 
entitlement email template is unselected, the merge tag [[FOR-EACH tag="EntitledProduct"]] 
iterates through products and includes product line information. Below is some sample code and an 
example of a resulting Entitlement email.

[[FOR-EACH TAG="Entitlement" child-only="true"]]
[[FOR-EACH TAG="EntitlementLineItem"]]

[[IF TAG="LicenseGenerator" VALUE="demo"]]
[[FOR-EACH tag="EntitledProduct"]]

Product Name: [[Name]]
Product Description: [[Description]]
Product Line: [[ProductLine]]

[[END FOR-EACH]]
Part Number: [[PartNumber]]
Permanent: [[Permanent]]
Start Date: [[StartDate]]
Expiry Date: [[ExpirationDate]]
ActivationID: [[ActivationID]]

[[END IF]]
[[END FOR-EACH]]

[[END FOR-EACH]] 

A resulting Entitlement email might look like this:

Figure 8: Entitlement email using the [[FOR-EACH tag="EntitledProduct"]] merge tag

New “Features” Column on List Entitlements Page 
(Case 02982636, SWM-25094)
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In the Producer Portal and the End-User Portal, the List Entitlements page can display an additional 
Features column, which would show the name and the version of the feature that is associated with a 
product. If a product includes more than one feature, a more... link is displayed. Pointing to the link 
lists all features that are linked to the product. 

This enhancement makes it easier for producers and their customers who might be more familiar with 
feature names than product names to identify and manage the features associated with a product. 

Displaying the Features Column

This enhancement is disabled by default. Producers who would like the Features column to be 
displayed should send a request to Revenera support. Revenera strongly recommends that producers 
ensure that displaying the Features column does not interfere with the way they currently use the List 
Entitlements page.

Figure 9: The List Entitlements page with the Features column displaying feature information in the 
Producer Portal 



FlexNet Operations 2025.05 ALM Release Notes (UAT)  (May 2025)  23

Figure 10: The List Entitlements page with the Features column displaying feature information in the 
End-User Portal 

User Experience Enhancements in 2025.04
The following user experience enhancement was added in the 2025.04 release.

• New In-App Messaging Functionality

• Improved Transaction Visibility in Producer Portal

• Updated Localizations of Field Labels on List Entitlements Page in End-User Portal

• Changes Around Security Question Now Localized

• New Endpoint for Displaying Date of Next Database Refresh

• Easier Login to Revenera Registry

New In-App Messaging Functionality
We are introducing a new capability in the FlexNet Operations Producer Portal, to help us modernize 
in-app messaging, streamline product on-boarding, and understand product usage. The main 
difference you should notice is improved messaging about FlexNet Operations maintenance, and new 
features being released.

However, the utility requires the use of optional cookies, and so upon logging into FlexNet Operations 
Producer Portal for the first time after this release, a pop-up will prompt your producer users to accept 
the cookie policy to enable the utility. (Until now, only essential cookies have been used in FlexNet 
Operations, which is why this is the first time we have introduced a cookie opt-out dialog. This dialog 
will only affect optional cookies for in-app messaging and product usage.)
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Refer to the FAQs article if you have additional questions.

Note •  This change will not affect the End-User Portal.  

Improved Transaction Visibility in Producer Portal
(SWM-24573, SWM-24815, SWM-24816, SWM-24820) 

Producers can now view all transactions performed on a device—whether initiated via web services or 
in the Producer Portal or End-User Portal—on the Search Transactions page in the Producer Portal 
(under System > Transaction History). There are four exceptions to the webservice-based transactions 
reported: 

• Move device from one account to another

• Return device when it is no longer in use

• Any changes initiated using generateCapabilityResponse

• Any requests to generate a clone detection report

These transactions will be added during the coming releases in Q2 this year.

Previously, only transactions performed through the Producer Portal or the End-User Portal interface 
were tracked in the Transaction History. 

This enhancement provides a comprehensive audit trail, enabling better tracking of past actions for 
compliance and troubleshooting purposes.

For more details, see the following sections:

• Tracked Operations

• Use Case Example

• Viewing Transaction Details

https://community.revenera.com/s/article/FlexNet-Operations-ALM-In-App-Messaging-FAQs
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Tracked Operations

Transactions are tracked for standalone devices, Cloud License Server instances and local license 
servers. The following table lists the operations of the ManageDeviceService web service that are now 
tracked: 

Use Case Example

Your company  provides industrial software licenses via FlexNet Operations. A customer complains 
that their software has stopped working. Your support team checks the Transaction History in the 
Producer Portal and sees that your customer’s own IT administrator mistakenly deactivated the 
license. Instead of escalating the issue, you can immediately guide them to reactivate their license, 
saving time and frustration.

Viewing Transaction Details

To view transaction details for a device, click System > Transaction History. On the Search Transaction 
History page, select the entity type Device, and enter any other search criteria. The Search 
Transactions: Results page displays a list of transactions. Click the View details link to see the details 
of a particular transaction. The details will look similar to this: 

Transaction Web Service Operation Event Type Description

Creating a device createDeviceRequest CREATE Tracks all successful and failed 
attempts to create a device. 

Linking 
entitlement line 
items to a device

linkAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was linked to 
a device, or where a metered 
license was removed from a 
device. 

Incrementing 
entitlement line 
items to devices

IncrementAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was 
incremented on a device. 

Updating a device updateDevice UPDATE Tracks transactions where a device 
was updated.
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Figure 11: The Transaction Details page showing updates made to a device

Updated Localizations of Field Labels on List Entitlements Page in End-User 
Portal
(SWM-22971) 

In the End-User Portal, on the List Entitlements page, two of the labels in the Search drop-down menu 
had been changed in the 2024.10 release to more meaningful names as well as to match the 
equivalent labels used in the Producer Portal (see User Experience Enhancements in 2024.10). The 
new labels are Sold-to Account Name and Sold-To Account ID.

To provide the same enhanced user experience for users of the localized interface of FlexNet 
Operations, the translations of these two labels have now been updated.

The following screenshot shows the List Entitlements page in the End-User Portal: 

https://docs.revenera.com/fno2024/rn/Content/helplibrary/User_Experience_Enhancements_in_2024_10.htm
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Figure 12: The Sold-to Account Name and Sold-to Account ID fields on the List Entitlements page in 
the End-User Portal now have more meaningful translations.

Changes Around Security Question Now Localized 
(SWM-25768) 

In the 2025.03 release, the dialog for the security question was updated for existing users who had 
selected “Where were you when you first heard about 9/11?” as their security question (see Removed 
Security Question). The warning text that was added in 2025.03 has now been translated and will 
appear in the localized versions of the End-User Portal. 

Figure 13: This screenshot shows the (English) text that has been localized in the 2025.04 release.

New Endpoint for Displaying Date of Next Database Refresh 
(Case 02912896, SWM-23482) 

https://docs.revenera.com/fno_CURRENT/rn/Content/helplibrary/User_Experience_Enhancements_in_2025_03.htm
https://docs.revenera.com/fno_CURRENT/rn/Content/helplibrary/User_Experience_Enhancements_in_2025_03.htm
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For Production Copy Service (PCS) environments, a new REST endpoint 
/flexnet/operations/rest/pcsRefreshDate has been introduced. When called, it returns the next 
production copy refresh date. The refresh date could be displayed in a banner like this: 

Figure 14: An example of a banner displaying the PCS refresh date.

Knowing the database refresh date can provide guidance when the PCS environment is used as a 
staging instance before deploying changes to the production environment. 

Easier Login to Revenera Registry
(SWM-20249)

An end customer wanting to pull a container image must first log into the registry. However, this 
presumes that the customer already knows the registry URL, which is not always the case. 

To make this process easier for customers, on the Downloads page, the End-User Portal now contains 
a new button, Container Registry login, which will copy the Docker login command with the 
appropriate tenant URL to the clipboard. Customers can then easily paste the command into the 
Docker command-line interface to log into the registry.
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Figure 15: The Downloads page of the End-User Portal with the new Container Registry login button.

SOAP and REST Web Services Enhancements in 2025.04
The following enhancement was added to the SOAP and REST Web Services module in the 2025.04 
release.

New Entitlement Management REST API
This release introduces the beta version of the first REST API in a series of new APIs aimed at 
simplifying integration with low-code platforms and improving overall performance. The first API, for 
creating a simple entitlement, is designed to streamline the process of creating entitlements in 
FlexNet Operations through an easy-to-use RESTful interface, making it ideal for low-code users. The 
new APIs are also optimized for performance, ensuring faster response times and improved scalability.

To authenticate requests to the Entitlement Management API, users must provide an authentication 
token, which can be obtained using the REST web service access-token-controller or using the 
Manage Access Tokens page in the Producer Portal.

For details about the new REST API, see the section RESTful Services for Entitlement Management in 
the Web Services Integration Guide.

Features and Enhancements in 2025.03
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.03 
release:

• Entitlement Management Enhancements in 2025.03

• User Experience Enhancements in 2025.03

Entitlement Management Enhancements in 2025.03
The following enhancements to entitlement management were added in the 2025.03 release.

https://docs.revenera.com/fno_CURRENT/webservicesintegration/Content/helplibrary/EntMgmtAPIIntro.htm
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• Inactive Line Items Can Now Be Changed to Draft to Allow Editing

• Warning Message When Activating Licenses for Upgrade Line Items

• Confirmation Message Displayed After Merging Entitlements

• Visibility of Product Lines Created by Other Producer Users

• Changing the Prefix for Trial Activation IDs

Inactive Line Items Can Now Be Changed to Draft to Allow Editing
(Case 02552542, SWM-25355) 

The 2025.03 release now allows producers to change the state of line items from Inactive to Draft. 
Previously, to edit an inactive line item, its status had to be changed to Deployed. This enhancement 
means that producers can edit or re-use previously inactive line items, without the need to deploy 
these line items first. 

Example: A producer wants to update the part number for a certain product. The products are already 
associated with entitlements, some of which are inactive. The producer can now change a line item’s 
status from Inactive to Draft, which then makes the line item editable. The producer can update the 
part number and then change the status back to Inactive.

The following screenshots show the Line Items section, where a line item has its status changed to 
Inactive, and the Customers to Licenses page with the subsequent success message.

Figure 16: Changing the line item status from Inactive to Draft in the Line Items section of the Entitle 
Customers to Licenses page
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Figure 17: The Entitle Customers to Licenses page shows a confirmation message after changing the 
line item’s status.

Warning Message When Activating Licenses for Upgrade Line Items
(Case 02733304, SWM-19396) 

In FlexNet Operations, when a base line item is associated with an upgrade line item, and the upgrade 
line item is activated, the quantity is consumed on the parent line. Returning the upgrade line item will 
not free up the count on the base line item. This is to prevent license leakage. 

However, customers who are not aware of this behavior might be frustrated. Imagine the following 
scenario: a customer upgrades to a new product version and activates the upgraded version. For some 
reason, the upgraded version of the product does not live up to their expections. When the customer 
tries to return the upgraded line item, in the hope of being able to use the previous product, they find 
that this is no longer possible. They now have no choice but continue using the upgrade that they do 
not like. 

To help users make conscious decisions when upgrading, FlexNet Operations now includes a new 
configuration option Display warning message when activating upgrade line item linked to parent line 
item (under System > Configure > FlexNet Operations > General Options). The option controls the 
behavior of the Producer Portal and the End-User Portal: 

• When the configuration option is selected, and a user tries to activate an upgrade line item that is 
linked to the parent line item (by navigating to the List Entitlements page, selecting an 
entitlement and clicking Activate), the following warning is displayed: 

“If you activate the selected upgrade line item, you will no longer be able to activate previous 
versions of that line item. Are you sure you want to activate the upgrade line item?“

This message makes it clear to the user that they cannot revert back to the previous version after 
the upgrade.

• When the configuration option is unselected, and a user tries to activate an upgrade line item that 
is linked to the parent line item, no warning message is be displayed. The Generate Licenses page 
opens for activating the license. (It is the Current Behaviour).
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Figure 18: Example of the warning message in the End-User Portal

Confirmation Message Displayed After Merging Entitlements
(Case 02974495, SWM-24762) 

Previously, when a user initiated a merge operation by selecting the assets to be merged and clicking 
Complete on the List Entitlements By Order | Merge Entitlements page, the Producer Portal redirected 
the user to the List Entitlements By Order page which then listed the merged assets. This behavior was 
confusing, because the user had no immediate way of knowing whether the merge was successful.

To improve the user experience, the List Entitlements By Order | Merge Entitlements page now 
displays a confirmation message which indicates whether the merge was successful. In the event of 
an error, a meaningful error message is displayed. 

The following screenshot shows the List Entitlements By Order | Merge Entitlements page with a 
confirmation message for a successful merge operation: 
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Figure 19: The confirmation message after a merge on the List Entitlements By Order | Merge 
Entitlements page

After the merge, users can navigate away from the page using the options in the top navigation bar. 

This enhancement applies to operations for merging entitlements and fulfillments and for merging 
users. 

Visibility of Product Lines Created by Other Producer Users
(Case 02774078, 02848224; SWM-20402)

In previous FlexNet Operations releases, a producer user could only access the product lines they 
created. However, this could create issues when system administrators left and new staff had to take 
over their responsibility for product lines. Product lines that were created by the previous 
administrator were not visible to the new administrators, making product line management very 
difficult. 

The 2025.03 therefore introduces a new configuration option Enable visibility of all product lines for 
system administrators (under System > Configure > FlexNet Operations > General Options). If 
enabled, the Product Lines section on the Create a User and Create an Account pages in the Producer 
Portal displays all product lines, including those created by other producer users. The Link product 
lines button in that section, which was previously limited to product lines created by the logged-in 
user, now allows linking of product lines created by other producer users. 

By default, the Enable visibility of all product lines for system administrators option is disabled.

Note that the configuration option Enable Product Lines for Products, Users, and Accounts (also under 
System > Configure > FlexNet Operations > General Options) must be selected for the new 
configuration option Enable visibility of all product lines for system administrators to be effective.



FlexNet Operations 2025.05 ALM Release Notes (UAT)  (May 2025)  34

Figure 20: When Enable Product Lines for Products, Users, and Accounts is selected, the Product 
Lines section on the Create a User page (pictured) and the Create an Account page displays all product 
lines, including those created by other producer users.  

Figure 21: Clicking Link product lines in the Product Lines section on the Create a User page and the 
Create an Account page displays the Select Product Lines for the User window, where producer users 
can link or remove a product line, including those product lines created by other producer users. 
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Changing the Prefix for Trial Activation IDs
(Case 02461881, SWM-21200)

The 2025.03 release allows producers to customize the short string that is used as a prefix for trial 
activation IDs. 

Previously, customization was not allowed. When a trial entitlement was created, its activation ID had 
the fixed prefix “Act”, which was a limitation when the entitlement needed to match or validate old or 
existing licenses and made trial conversions or renewals difficult. A configurable prefix gives 
producers the flexibility to match the activation IDs in these various phases.

Producers wanting to change the prefix can do so in the configuration option Custom pre-fix string 
from Trial License Activation ID (under System > Configure > FlexNet Operations > General Options). 

User Experience Enhancements in 2025.03
The following user experience enhancement was added in the 2025.03 release.

Removed Security Question
(Case 02954443, SWM-24008) 

When users set or change their password for the Producer Portal or the End-User Portal, they need to 
select a security question as an additional authentication factor. In previous releases, the list of 
security questions included the question “Where were you when you first heard about 9/11?”. In the 
2025.03 release, inclusion of this question has changed because it could be distressing for some 
users:

• New users and users who did not use 9/11 as a security question will no longer see the question 
“Where were you when you first heard about 9/11?” when they are setting their password and 
security question. 

• Existing users who had already selected “Where were you when you first heard about 9/11?” as 
their security question are not forced to select a different security question. Instead, they will see 
a warning message, “This security question is deprecated and is recommended to be changed.” 
This approach gives existing users time to select a new security question. Once they selected a 
different security question, the message is no longer displayed.

The following screenshot shows the screen presented to existing users: 
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Figure 22: Existing users are informed that the 9/11 security question is deprecated.

These changes apply to the Producer Portal and End-User Portal.

Features and Enhancements in 2025.02
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.02 
release:

• Data Analytics Enhancements in 2025.02

• Entitlement Management Enhancements in 2025.02

• SOAP and REST Web Services Enhancements in 2025.02

Data Analytics Enhancements in 2025.02
The following enhancement was made to the Analytics functionality in 2025.02.

New Report to Analyze Denied Access Requests
The License Server Usage report (under Analytics > License Server Usage) has been expanded to 
include a new chart, called Denials Distribution, covering denials data. To reflect this new capability, 
the License Server Usage report has been renamed to License Server Usage and Denials. 

The License Server Usage and Denials report analyzes the denials made by a Cloud Licensing Service 
(CLS) instance, Dynamic Monetization instance or a local license server and provides insights into 
causes and patterns where requests to access licensed software were rejected. The report reveals 
details about:

• Denial reasons—Reasons are grouped by the denial status code, along with the percentage 
distribution per denial code. Identifying the most common reasons for denials—such as, for 
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example, insufficient feature counts or elastic tokens, expired features, features not available due 
to rule rejection—allows producers and their customer to take corrective action.

• Denial patterns—Discover which accounts are experiencing the highest number of denials. This 
information helps producers uncover key accounts that might not be sufficiently provisioned with 
licenses to meet their day-to-day operational requirements.

• Denial trends—Patterns in denied requests can help producers forecast future demand for certain 
features, products, or license types. This insight supports better resource allocation, product 
development, and infrastructure planning to meet anticipated growth.

Clicking the Denials Distribution chart opens a new page which shows the Denials Distribution pie 
chart, the Denials by Account bar chart, and the Denials Summary table (described below).

Note • For usage data from a local license server to be available in the Data Warehouse, the following 
policy settings must be configured:

• usageService.sync.enabled—Must be set to true.

• usageService.sync.url—Must point to the usage service URL, which is

https://<siteId>.compliance.flexnetoperations.com/usage/api/1.0/sync

where <siteId> is replaced with the specific site ID supplied by Revenera, for example: 

https://flex1234.compliance.flexnetoperations.com/usage/api/1.0/sync 

• licensing.trackDeniedRequests—Must be set to true if the usage data should also include denied 
request information. To disable tracking of denied requests, licensing.trackDeniedRequests set to 
false. 

For more information, see the topic “Pushing Usage Data to the Data Warehouse” in the FlexNet 
Embedded License Server Producer Guide (available from the Product and License Center). 

Denials Distribution Pie Chart

The Denials Distribution pie chart visualizes the different types of denials along with their percentage 
distribution, providing insights into denial patterns. Hover over a pie slice to see the following 
information:

• Denial status code and description

• Absolute number of denials

• Percentage of denials

You can filter the pie chart using the using the widget filter at the top, to focus on specific denial status 
codes, accounts, or other criteria.

https://flexerasoftware.flexnetoperations.com/
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Figure 23: Example of a Denials Distribution pie chart

Denials by Account Bar Chart

The Denials by Account bar chart shows the denials segmented by account, offering valuable insights 
into the key accounts that should be prioritized for revenue generation opportunities.

Figure 24: Example of a Denials by Account bar chart
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Denials Summary Table

The Denials Summary table offers detailed insights into denials, showing data such as users/clients, 
features and timestamp, enabling data-driven conversations with customers.

Insights Gained From the Denials Distribution Report

The following example illustrates how producers might benefit from the insights provided by the 
Denials Distribution report.

Let’s assume that your Software as a Service (SaaS) company offers subscription-based software 
licenses, but users frequently face license checkout denials when trying to access the software. You 
generate a Denials Distribution report to analyze the issue. The screenshot below shows the findings 
of the report:
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The report lists the most common denial reasons, which enables you to take action and turn the 
denials into upsell or cross-sell opportunities. This in turn also reduces the impact on your customer 
support team.

Table -1 • Example Findings of a Denials Distribution report

Denial Reason
Denial 
Rate (%) Insights Opportunity

Insufficient feature 
count available 

Insuffient elastic tokens 
available (Dynamic 
Monetization) 

45% The main reason for 
denials is that 
demand exceeds the 
current subscription 
plan.

Upselling additional licenses:

Sales, the Renewals team or 
Customer Sucess Managers can 
leverage the report’s insights to 
discuss upgrading the subscription 
plan, introduce dynamic license 
allocation or on-demand scaling with 
the customer.

Feature expired

No valid active line 
items (Dynamic 
Monetization)

25% Loss of revenue due 
to missed renewals.

Increase renewal opportunities: 

Engage the Renewals team to lead 
data-driven conversation with the 
customer. 

Send proactive renewal reminders, set 
up automated renewal reminders, or 
enable auto-renewal.

Feature unavailable

Item not found in any 
effective rate table 
(Dynamic Monetization)

15% User attempting to 
access a premium 
product not included 
as part of the 
current subscription 
plan.

The Sales or Renewals team can 
leverage this opportunity for cross-
selling or upselling.
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Entitlement Management Enhancements in 2025.02
The following enhancements to entitlement management were added in the 2025.02 release.

• Error Message When Activating Obsolete/Inactive Line Items

• Overhaul of the “Show Line Items with Zero Copies by Default” Configuration Option

Error Message When Activating Obsolete/Inactive Line Items
(Case 02954549, SWM-23892) 

Previously, attempting to activate an obsolete or inactive line item on a device using a FlexNet 
Embedded toolkit failed as expected, but no error message was displayed. This lack of error messages 
while activating obsolete or inactive line items made it difficult for producers to notice and resolve 
errors in a timely manner. 

From the 2025.02 release onwards, attempting to activate an obsolete or inactive line item will result 
in an error being displayed. For example, the response might include a status like this:

Status=("Activation ID not permitted": 5f4d-123e-a456-7894-b123-66f4-88h7-56f3)

This screenshot shows a sample response: 

Feature unavailable, 
checkout filter rejection

Feature unavailable, 
rule rejection

10% Users unable to 
activate software 
due to rules of 
access or feature 
selectors.

Opportunity to upsell additional 
licenses:

The denials might indicate additional 
demand for a feature.

Customer Sucess Managers could 
share this report with the enterprise 
license administrator to enable them 
to:

• Identify users/clients unable to 
activate software due to certain 
restrictions, but who require 
access to features.

• Adjust feature selectors and rules 
of access to allocate licenses to 
users/client/departments that 
derive the most value from the 
software. 

Table -1 • Example Findings of a Denials Distribution report

Denial Reason
Denial 
Rate (%) Insights Opportunity
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This enhancement enables producers to identify the cause of the error and take corrective action, if 
required.

Overhaul of the “Show Line Items with Zero Copies by Default” 
Configuration Option
(Case 02876825, SWM-24336)

In previous releases, the configuration option Show Line Items with Zero Copies by Default (under 
System > Configure > FlexNet Operations > General Options) did not work as expected. It has now 
undergone an overhaul to fix functional issues and broaden its scope:

• In previous releases, even if the configuration option was disabled, the List Entitlements in the 
End-User Portal page erroneously displayed line items with zero copies remaining. This has now 
been resolved.

• The previous description of the configuration was misleading, because it referred to the page 
names “Activatable Items” and “Entitlements” that do not exist in the End-User Portal. The 
wording has now been corrected to refer to the “List Entitlements” page.

• The scope of the configuration option has been broadened. Whereas previously it controlled only 
which entitlements would be displayed on the List Entitlements page in the End-User Portal, it 
now also controls which entitlements are displayed on the List Entitlements page of the Producer 
Portal. To reflect this, the description has been changed as follows: “Select to show line items 
with zero copies by default in the List Entitlements page in the Producer Portal and End-User 
Portal.”

This enhancement gives producers and their end-users greater control over the content displayed 
on the List Entitlements pages.

How the option affects which line items are displayed in 2025.02 

When Show Line Items with Zero Copies by Default is selected, the Producer Portal and the End-User 
Portal show line items with zero copies remaining on their List Entitlements pages. The List 
Entitlements page is available in the Producer Portal under Entitlements > List Entitlements and in the 
End-User Portal under Activation & Entitlements > List Entitlements. 

When Show Line Items with Zero Copies by Default is unselected (the default), line items with zero 
copies are hidden on the List Entitlements pages.

Note • A known issue exists; see SWM-24042: Input Sanitization Disabled.
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SOAP and REST Web Services Enhancements in 2025.02
The following enhancements were added to the SOAP and REST Web Services module in the 2025.02 
release.

• Returning Fulfillment and License Information for Non-Embedded Technologies Using Web 
Services

• New Operation for Getting Host Count in License Service SOAP Web Service

Returning Fulfillment and License Information for Non-Embedded 
Technologies Using Web Services
(Case 02370066, SWM-22714) 

In the Producer Portal, producers can list fulfillment or license information for non-embedded 
licensing technology (such as FlexNet Publisher) for specific hostids on the Support Licenses and 
Maintenance page (under Licenses > Hosts). The following screenshot shows the Support Licenses 
and Maintenance page along with the search options:

To provide the same functionality using web services, the 2025.02 release now introduces version 2 of 
the LicenseService SOAP web service. This enhancement enables producers to do the following:

• Collect all hostids to provide a list of current hostids for new activations

• Collect all active fulfillments for a dedicated server in preparation to create "emergency" licenses 
for that server

• Collect fulfillment and license information in preparation to rehost a server

Implementation of getHostQuery

Version 2 of the LicenseService SOAP web service includes the new operation getHostQuery. The 
following XML fragment illustrates a getHostQuery message:

<operation name="getHostQuery">
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<input message="tns:getHostQueryRequest"/>
<output message="tns:getHostQueryResponse"/>

</operation>

The operation getHostQuery extracts the same information as that available on the Support Licenses 
and Maintenance page: Host ID, Sold To, Account, License Technology, and Host Type. In addition, 
producers can filter for hosts that have active or inactive fulfillments.

Tip • For pagination, producers can use the getHostCount operation to determine the number of hosts 
and specify that number in the batchSize parameter (see New Operation for Getting Host Count in 
License Service SOAP Web Service).

The following snippet shows sample XML code: 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v2.webservices.operations.flexnet.com">
   <soapenv:Header/>
   <soapenv:Body>
      <urn:getHostQueryRequest>
         <!--Optional:-->
         <urn:queryParams>
            <!--Optional:-->
            <urn:hostId>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:hostId>
            <!--Optional:-->
            <urn:soldTo>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:soldTo>
            <!--Optional:-->
            <urn:licenseTechnology>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:licenseTechnology>
            <!--Optional:-->
            <urn:hostType>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:hostType>
            <!--Optional:-->
            <urn:account>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:account>
            <!--Optional:-->
            <urn:fulfillmentState>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:fulfillmentState>
         </urn:queryParams>
         <urn:pageNumber>?</urn:pageNumber>
         <urn:batchSize>?</urn:batchSize>
      </urn:getHostQueryRequest>
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   </soapenv:Body>
</soapenv:Envelope>

For detailed information about the changes made to the LicenseFulfillmentService.wsdl and the 
.xsd files that it references, see the Change Log for 2025.02.

New Operation for Getting Host Count in License Service SOAP Web Service 
(Related to Case 02370066, SWM-25245) 

Along with the getHostQuery operation (see Returning Fulfillment and License Information for Non-
Embedded Technologies Using Web Services), version 2 of the LicenseService SOAP web service also 
introduces the getHostCount operation. getHostCount returns the number of hosts that match 
specified criteria. 

This operation is equivalent to displaying the number of hosts that fit certain criteria by filtering hosts 
using the Search for option in the Producer Portal in the Support Licenses and Maintenance page:

Implementation of getHostCount

The following XML fragment illustrates a getHostCount message:

<operation name="getHostCount">
<input message="tns:getHostCountRequest"/>
<output message="tns:getHostCountResponse"/>

</operation>

The operation getHostCount returns the number of hosts that fit specified criteria. The following 
search criteria are available: Host ID, Sold To, Account, License Technology, and Host Type. 
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Tip • The returned number can be used as the batch size input for getHostQuery (see Returning 
Fulfillment and License Information for Non-Embedded Technologies Using Web Services).

The following snippet shows sample XML code: 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v2.webservices.operations.flexnet.com">
   <soapenv:Header/>
   <soapenv:Body>
      <urn:getHostCountRequest>
         <!--Optional:-->
         <urn:queryParams>
            <!--Optional:-->
            <urn:hostId>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:hostId>
            <!--Optional:-->
            <urn:soldTo>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:soldTo>
            <!--Optional:-->
            <urn:licenseTechnology>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:licenseTechnology>
            <!--Optional:-->
            <urn:hostType>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:hostType>
            <!--Optional:-->
            <urn:account>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:account>
            <!--Optional:-->
            <urn:fulfillmentState>
               <urn:value>?</urn:value>
               <urn:searchType>?</urn:searchType>
            </urn:fulfillmentState>
         </urn:queryParams>
      </urn:getHostCountRequest>
   </soapenv:Body>
</soapenv:Envelope>

For detailed information about the changes made to the LicenseFulfillmentService.wsdl and the 
.xsd files that it references, see the Change Log for 2025.02.
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Features and Enhancements in 2025.01
Features and enhancements were added to the following areas of FlexNet Operations in the 2025.01 
release:

• Entitlement Management Enhancements in 2025.01

• User Experience Enhancements in 2025.01 

• Device Management Enhancements in 2025.01

• Dynamic Monetization Enhancements in 2025.01

Entitlement Management Enhancements in 2025.01
The following enhancement to entitlement management was added in the 2025.01 release.

Instance ID Merge Tag Now Available in Entitlement Email Template
(Case 02875263, SWM-21918) 

Previously, the merge tag [[DEFAULT_GLS_INSTANCE_ID]] (available in the Entitlement email template)  
could only be included above the email text, but not in the email within LicenseModel or 
EntitlementLineItem tags. 

In the 2025.01 release, the merge tag [[DEFAULT_GLS_INSTANCE_ID]] can be nested inside the 
LicenseModel or EntitlementLineItem tag, and producers can now insert the Cloud Licensing Service 
(CLS) instance ID into the table in an Entitlement email. (This allows an Entitlement email, for example, 
to contain a table with rows for each line item, and to specify the CLS ID in the rows related to the CLS.)

The following sample shows how the merge tag [[DEFAULT_GLS_INSTANCE_ID]] is nested inside the 
EntitlementLineItem tag:

[[FOR-EACH TAG="EntitlementLineItem"]]
[[DEFAULT_GLS_INSTANCE_ID]]

[[END FOR-EACH]]

User Experience Enhancements in 2025.01
The following user experience enhancement was added in the 2025.01 release.

New Configuration Hides Menu Options for Making Entities Obsolete 
(Case 02902521, SWM-22852) 

In FlexNet Operations, the status "Obsolete" is typically used to remove entities (for example, products, 
features, feature bundles, devices, suites, and license models) from use permanently. This status 
helps distinguish outdated or superseded entities from those currently in use, without completely 
deleting them from the system.

However, producers need to use great care when setting an entity’s status to Obsolete, because the 
status Obsolete is permanent and cannot be reverted. The 2025.01 release therefore introduces the 
configuration option Allow state change of entities to obsolete (under System > Configure > FlexNet 
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Operations > General Options), which enables producers to hide the Obsolete or Make Obsolete menu 
options in the Producer Portal. Specifically, when the option is unselected, the Obsolete or Make 
Obsolete menu options are no longer displayed in the following locations in the Producer Portal:

• Entitlements > List Entitlements By Order > Change State menu

• Entitlements > Create  > Line Items and Maintenance Line Items tabs > Change State menu

• Devices > Devices > clicking the hyperlinked device name opens the Device or View Server page > 
Edit menu

• Products > Products > Change State menu

• Products > Features > Change State menu

• Products > Feature Bundles > Change State menu

• Products > Suites > Change State menu

• Administer > License Models >  Change State menu

Unselecting Allow state change of entities to obsolete prevents users from—accidentally or 
intentionally—changing the state of products, features, feature bundles, devices, suites, license 
models, and similar entities, to Obsolete using the user interface. However, entities can still have their 
status changed to Obsolete using an API web service call.

By default, Allow state change of entities to obsolete is selected.

Note • Operations that involve changing an entity’s state to Obsolete as part of a transfer or upgrade 
process are not impacted.

Device Management Enhancements in 2025.01
The following enhancement to device management was added in the 2025.01 release:

Reassigning Returned Standalone Devices
(Case 01948947, SWM-20276) 

This release includes an enhancement for returned standalone devices.

Returning a device is intended for devices that no longer receive capability responses or license files, 
or servers that no longer serve devices or communicate with the FlexNet Operations back office. 
Previously, returning a device was an irreversible action. When a device was returned, it was 
permanently disassociated from its account. 

The 2025.01 release introduces the ability to reassign returned standalone devices to an account and 
reactivate such devices. This enables producers to take returned standalone devices back into service.

Reassigning a Device Using the Producer Portal 

Producers can reassign a returned device to an account using the menu item Reassign Account from 
the Edit menu on the Device page. (To access the Device page for a returned device, click Devices > 
Devices  > click a hyperlinked device name.) 
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Note • Returned devices have a status of Returned and are by default not listed on the Devices page 
(under Devices > Devices) even when searched. To display returned devices on the Devices page, 
select the option Inactive in the filter above the devices list.

The following screenshot shows the new menu item Reassign Account on the Device page:

Clicking Reassign Account opens the Assign account page, where you can select a new account for 
the device. 
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After a standalone device has been reassigned to an account, the device status is changed to Active. 
The device can now have entitlements mapped to it. 

Reassigning a Standalone Device Using Web Services

Returned standalone devices can also be reassigned using the updateDevice operation of the 
ManageDeviceService web service. 

The following code snippet illustrates how to use the updateDevice operation:

<urn:updateDeviceRequest>
<urn:device>
<urn:deviceIdentifier>
<urn:deviceType>CLIENT</urn:deviceType>
<!-- Note: This is the device to be updated, currently in RETURNED state -->
<urn:deviceId>Test123</urn:deviceId>
<urn:deviceIdType>STRING</urn:deviceIdType>
<urn:publisherName>fnepublisher</urn:publisherName>

</urn:deviceIdentifier>
<urn:updateChannelPartners>
<urn:channelPartners>
<urn:channelPartner>
<!-- Note: Only END CUSTOMER is supported as per existing functionality-->
<urn:tierName>bo.constants.partnertiernames.endcustomer</urn:tierName>
<!-- Note: This is the account to which the device is to be reassigned -->
<urn:accountUnit>



FlexNet Operations 2025.05 ALM Release Notes (UAT)  (May 2025)  51

<urn:primaryKeys>
<urn:name>MyAccount</urn:name>

</urn:primaryKeys>
</urn:accountUnit>

</urn:channelPartner>
</urn:channelPartners>
<!-- Note: Only REPLACE is supported as per existing functionality-->
<urn:opType>REPLACE</urn:opType>

</urn:updateChannelPartners>
</urn:device>

</urn:updateDeviceRequest>  

There have been no changes to any of the .wsdl or .xsd files for SOAP services.

Reassigning a Standalone Device Using the End-User Portal 

To use a returned standalone device in the End-User Portal, the device must first be reassigned to an 
account using the Producer Portal. Once it has been assigned to an account, an end user can claim the 
device in the End-User Portal by clicking Devices > Claim and Activate.

Note • The Claim and Activate option only appears in the Devices menu of the End-User Portal for 
users with roles specifically granted the End-User Portal permissions Claim Device and Activate and 
Generate Licenses.

Dynamic Monetization Enhancements in 2025.01
The following enhancement for Dynamic Monetization was added in the 2025.01 release.

Allowing Overdrafts in Elastic Access
(SWM-23936)

When end customers run out of Elastic Access tokens before the expiration of a line item, producers 
may want to allow them to continue using capabilities and to consume tokens until a new purchase of 
tokens can be arranged. To enable end customers to consume tokens beyond their entitled count, 
Elastic Access now allows an overdraft limit to be provided on line items. The recorded usage data 
provides a basis for subsequent billing.

In the Producer Portal, Elastic Access license models can be set up using a new overdraft attribute. 
Producers can specify the overdraft using one of the following settings:

• Not used

• Unlimited

• Specify # now

• Specify % now

• Specify % at entitlement time

The default setting is Not used, and a zero overdraft limit will be enforced if this setting is chosen.
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When an overdraft is set, line items using this license model will be configured with the value, allowing 
end customers to consume tokens from the line item up to the overdraft limit above the entitled 
quantity.

If Unlimited is selected, then an “infinite” overdraft limit is used, and end customers can consume 
tokens without constraint. 

In the Producer Portal, producers set the overdraft for Elastic Access license models on the Package 
Products - License Models | Create A License Model page (under Administer > License Models > 
Create new license model), as shown here: 

Producers who use a back office other than FlexNet Operations can set the overdraft directly in the 
/line-items API, using the attributes parameter and the overdraftLimit and overdraftType 
properties. 

To allow an unlimited overdraft, set overdraftType to Unlimited. 
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To allow a limited overdraft, set  overdraftType to Number and set overdraftLimit to the number of 
tokens that can be consumed from the line item above the entitled quantity. 

The following snippet shows a sample request for a limited overdraft:

{
"activationId": "string",
"state": "string",
"quantity": 1,
"start": 0,
"end": 0,
"attributes": {

"elastic": false,
"rateTableSeries": "",
"overdraftLimit": 100,
"overdraftType": "Number"

}
}

For details about this API, see the Dynamic Monetization API documentation, topic Map a line item to 
an instance (https://fnoapi-dynamicmonetization.redoc.ly/#operation/addActivation).

The overdraft details are recorded in the Usage Metrics table in the Snowflake Data Warehouse (field 
OVERDRAFT_COUNT) and can also be returned using the Data Access API (field overdraftCount). For 
more information, see the Data Access API and Data Share Entity Relationship Details.

System Requirements
Detailed system requirements for FlexNet Operations include the following.

Requirement Description

Web browsers • Microsoft Edge 

• Mozilla Firefox 75.0 

• Google Chrome 80.0.3987.163 

FlexNet licensing module • FlexNet Publisher Toolkit 11.12.0 or later 

• FlexNet Embedded Toolkit 2015 R2 or later 

Note • FlexNet Operations supports these FlexNet Embedded 
host ID types: ETHERNET, INTERNET, INTERNET_6, FLEXID9, 
FLEXID10, STRING, USER, VM_UUID, EXTENDED, 
PUBLISHER_DEFINED, and CONTAINER_ID.

https://fnoapi-dynamicmonetization.redoc.ly/#operation/addActivation
https://fnoapi-dynamicmonetization.redoc.ly/#operation/addActivation
https://fnoapi-dynamicmonetization.redoc.ly/#operation/addActivation
https://docs.revenera.com/fno_CURRENT/fnoapi-da/fnoapi_dataaccess_reportfields.htm
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Resolved Issues
The following sections describe the issues that have been resolved in the FlexNet Operations 2025 
releases to date:

• Issues Resolved in 2025.05

• Issues Resolved in 2025.04

• Issues Resolved in 2025.03

• Issues Resolved in 2025.02

• Issues Resolved in 2025.01

Issues Resolved in 2025.05
An issue in the following area was resolved in the FlexNet Operations 2025.05 release:

• Data Analytics Issues Resolved in 2025.05

• Entitlement Management Issues Resolved in 2025.05

• Export and Import Issues Resolved in 2025.05

• Security Issues Resolved in 2025.05

• User Experience Issues Resolved in 2025.05

Vendor certificate generator The current versions of the VCG kit are 12.11.0 and 16.2.2.0. 

These VCGs were tested with the following compilers: 

• Windows—Visual Studio 2010 Professional Edition 

• Linux—gcc 4.1.2 (RHEL 5.0) 

• Linux—gcc 4.4.4 (RHEL 6.0) 

Note • The 12.11.0 VCG is built with FlexNet Publisher 11.11.1 
and shares the same minimum C compiler requirements on each 
supported platform. (See the FlexNet Publisher 11.11.1 release 
notes for C/C++ compiler support.) 

High Speed File Upload If you intend to use the High Speed Upload option to upload files, 
the following plug-in is required:

Aspera Connect 3.10.0 or later

Requirement Description
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Data Analytics Issues Resolved in 2025.05
The following issue was resolved for the Analytics functionality in the 2025.05 release.

Changes to Download Data and File Size in Analytics Dashboard
(SWM-26838)

The following changes were made which affect the Software Delivery Download History report 
(available from the Analytics menu).

Download Data

Previously, no date filter was applied to the data in the Software Delivery Download History report; its 
figures were based on all data available at the time in the Data Warehouse and therefore lacked 
relevance from a business perspective. 

To address this, a default filter is now active which restricts download data to the last 12 months. For 
example, on April 18th, 2025, the data fetched ranges from April 18, 2024 to April 18, 2025.

This filter allows producers to gain insights into software downloads within the past 12 months. 

To fetch data for a shorter or longer period, producers can edit the DOWNLOAD_START_DATE filter in the 
Filters panel.

Figure 25: By default, the DOWNLOAD_START_DATE filter is set to show download data for the last 12 
months from the current date.

File Sizes

File sizes are now measured using the decimal system (base 10), rather than binary conversion. This 
means that 1 KB equals 1000 bytes, not 1024 bytes as in the binary system.

This way of calculating data sizes is now consistent between the Analytics functionality and FlexNet 
Operations Reporter.



FlexNet Operations 2025.05 ALM Release Notes (UAT)  (May 2025)  56

Entitlement Management Issues Resolved in 2025.05
The following issue was resolved for entitlement management in the 2025.05 release.

Download Now Link in End-User Portal Now Working As Expected
(Case 02989988, SWM-25688)

In the End-User Portal, download packages could previously not be downloaded from either the New 
Versions or Previous Versions tab on the Download Order page. (The Download Order page is available 
by selecting Activation & Entitlements > List Entitlements and clicking the Download Now link for an 
entitlement). Instead of a download link, both tabs showed the error message “There are currently no 
available downloads defined for your account.” However, downloads were indeed available, as 
confirmed on the List Downloads page.

This problem has now been resolved. If a user has an entitlement that has download packages 
associated, they will be able to download the download packages from the New Versions tab. 

In addition, expired or archived download packages are now displayed and can be downloaded from 
the Previous Versions tab. 

Figure 26: The Download Order page now shows expired or archived download packages on the 
Previous Versions tab. 

Export and Import Issues Resolved in 2025.05
The following issue related to the Data Export and Import functionality was resolved in the 2025.05 
release.

Account Data Export
(Cases 03030706, 03032924; SWM-26609)

In this release, the functionality for exporting accounts information has been restored. 
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In its Export menu, the Manage Accounts page (available from Accounts & Users > All Accounts) now 
shows the correct option, Data Import Template. Clicking Export > Data Import Template triggers an 
export job, which creates a downloadable Data Import Template (.xlt) file containing the relevant 
entities.

The image below shows the option Data Import Template which is used to export accounts 
information: 

Figure 27: The Export menu now contains the correct option, Data Import Template, for exporting 
accounts information.

Previously, in its Export menu, the Manage Accounts page showed the options Selected Items and 
Selected Items with Their Dependencies, which had no underlying functionality (.JAR export is not 
available for accounts and users). 

Security Issues Resolved in 2025.05
The following issue related to FlexNet Operations security was addressed in the 2025.05 release.

Upgraded Chart.js
(Case 02999121, SWM-25776)

The Chart.js library has been upgraded to version 2.9.4 to address potential security vulnerabilities.

User Experience Issues Resolved in 2025.05
The following issue related to user experience was addressed in the 2025.05 release.

• System Roles No Longer Visible in Portals

• Resolved Issue of Incorrectly Formatted Page in End-User Portal

System Roles No Longer Visible in Portals
(Cases 03009399, 03009414, 3011796; SWM-26277)

The system roles Default Producer Role and Manage Impersonated Access Tokens PP, and Default 
Portal Role and Manage Impersonated Access Tokens EP are no longer visible in the Producer Portal 
and the End-User Portal, respectively.
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These roles are not intended for selection by producers or end users. To avoid that they are mistakenly 
assigned they are now hidden from the Producer Portal and End-User Portal.

Note • The roles Manage Impersonated Access Tokens PP and Manage Impersonated Access Tokens 
EP contain permissions for issuing so-called impersonated access tokens, which are a means to 
securely authorize SOAP and REST web service calls to FlexNet Operations. While the term 
“impersonated” might sound concerning, it simply refers to a mechanism where a privileged user can 
securely act on behalf of another user with limited permissions.

Resolved Issue of Incorrectly Formatted Page in End-User Portal 
(Case 02411062, SWM-26279)

In the End-User Portal, when associating an existing user to an account, the page for selecting users 
was not correctly formatted. 

The issue could be seen by following these steps: 

1. Click Accounts & Users > List Accounts. 

2. On the Accounts page, click a hyperlinked account ID. 

3. In the Account Users section, click Actions > Link existing users.  

4. Click the pagination arrow to see the next set of users.

5. You will see the page with formatting issues:

This issue no longer occurs. 

Issues Resolved in 2025.04
An issue in the following area was resolved in the FlexNet Operations 2025.04 release:

• Electronic Software Delivery Issues Resolved in 2025.04
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Electronic Software Delivery Issues Resolved in 2025.04
The following issue was resolved for Electronic Software Delivery (ESD) in the 2025.04 release.

Uploading New File Versions Will Update Existing Content
(Cases 02225917, 02567912, 02680773, 02834194, 02918066, 02918272, 02995536, 03003837, 
03008991; SWM-19909)

Previously, when uploading a new version of a file (or package) whose previous version existed in the 
Software Delivery system, it was recommended to use a new file name. This best practice prevented 
the delivery of “stale” file content to customers, because uploading a new file with the same file name 
would not reliably overwrite the existing file. 

Now, you can upload new content using an existing file name, which will replace the existing content. 

Issues Resolved in 2025.03
Issues in the following areas were resolved in the FlexNet Operations 2025.03 release:

• Account and User Management Issues Resolved in 2025.03

• Electronic Software Delivery Issues Resolved in 2025.03

• Entitlement Management Issues Resolved in 2025.03

• Export and Import Issues Resolved in 2025.03

• Security Issues Resolved in 2025.03

Account and User Management Issues Resolved in 2025.03
The following issues involving the management of accounts and users was resolved in the 2025.03 
release.

• Users With Expired Accounts No Longer Fail to Update

• Partners Can Now Filter Devices by Account Name and ID in End-User Portal

Users With Expired Accounts No Longer Fail to Update
(Case 02917771, SWM-24640)

In previous releases, when an account was linked to a user whose association with a different account 
had expired, the account could not be updated. When attempting to update such an account, FlexNet 
Operations returned an error message. The following example illustrates the scenario in which the 
error was displayed:

1. The following two end-customer accounts exist: account ACME and account INDIGO.

2. User A is linked to account ACME. The expiry date was set using the Data Import template; and the  
association between user A and account ACME is set to expire on January 10. 

3. On January 28, you want to link user A to the INDIGO account. This fails with the error message 
“Expiry date should be either today or after date”
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If the user expiry was set via web services or the Producer Portal user interface, and the date has 
passed, the user could be linked to another account. The problem occurred only when the expiry date 
was set via the Data Import template.

This issue has now been resolved. Users whose expiry dates are set using the Data Import template 
are allowed to be linked to other accounts when those expiry dates have passed. If a user is expired on 
one account, this does not prevent the linking on another account.

Partners Can Now Filter Devices by Account Name and ID in End-User Portal 
(Cases 02114107, 02908843; SWM-6311) 

Previously, when a channel partner logged in to the End-User Portal and tried to filter the Devices page 
for devices by account ID or account name, the query did not return any devices. This limitation made it 
difficult for partners to assist their customers with license allocation and troubleshooting.

In the 2025.03 release, this limitation has been addressed, and channel partners can now filter the 
Devices page for devices by account ID or account name.

Figure 28: Example screenshot showing filtering devices by account name 

Electronic Software Delivery Issues Resolved in 2025.03
The following issue was resolved for Electronic Software Delivery (ESD) in the 2025.03 release.

Download Package Search No Longer Returns Duplicate Counts 
(Case 02988915, SWM-25228)

When retrieving download package counts using the getDownloadPackageCount operation of the 
DownloadPackagingService web service or using the Search Download Packages page in the Producer 
Portal, the query could return incorrect counts. This issue occured in the following scenarios:

• The getDownloadPackageCount operation returned an incorrect count if a download package had 
multiple values set for a multi-value text custom attribute.



FlexNet Operations 2025.05 ALM Release Notes (UAT)  (May 2025)  61

• The Search Download Packages page returned duplicate values when searching for a download 
package using a wildcard character (*) in a custom attribute. 

Figure 29: Previously, using a wildcard (*) in a custom attribute when searching for download 
packages could cause the Producer Portal to return duplicates.

This issue has now been resolved. The fix for the getDownloadPackageCount operation applies to all 
versions of the DownloadPackagingService web service.

Entitlement Management Issues Resolved in 2025.03
The following issues were resolved for entitlement management in the 2025.03 release.

• Google reCAPTCHA Challenge Now Displays Complete Set of Pictures, Allowing to Send 
Entitlement Emails

• Saving a Feature with Space in Version Number Triggers Meaningful Error Message

• Rearranging Features on the Products Page in the Producer Portal

• Filter "Is remaining copies more than zero?" Now Working as Expected in Producer Portal

• Resolved Discrepancy Between Number of Entitlements in End-User Portal and Producer Portal

Google reCAPTCHA Challenge Now Displays Complete Set of Pictures, 
Allowing to Send Entitlement Emails
(Case 02552507, SWM-20758)

In the Producer Portal, if the Google reCAPTCHA challenge is active, the Google reCAPTCHA challenge 
now displays a complete set of pictures when attempting to send entitlement emails from the List 
Entitlements page. 

To send an email from the List Entitlements page (under Entitlements > List Entitlements), select an 
entitlement and click Email. On the next page, click I’m not a robot. The Google reCAPTCHA challenge 
displays a set of pictures and prompts you to select certain pictures to prove that you are human 
before sending the email.
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Previously, some of the pictures were missing, making it impossible for users to complete the 
challenge and send emails from the List Entitlements page (by selecting an entitlement and clicking 
Email). 

The following screenshots show an example of the reCAPTCHA screen with missing pictures and the 
same page with the fix:

Figure 30: Entitlement email with corrupted reCAPTCHA panel
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Figure 31: Entitlement email with fixed reCAPTCHA panel, showing all pictures. 

Note • To use Google reCAPTCHA, the following configuration options must be set: 

• Recaptcha Site key and Recaptcha Secret password (under System > Configure > FlexNet 
Platform Server > General Options)

• Use Recaptcha validation when sending entitlement emails (under System > Configure > FlexNet 
Operations > General Options) must be selected.

Saving a Feature with Space in Version Number Triggers Meaningful Error 
Message
(Case 02990348, SWM-25307)

In previous releases, when a feature was created with the Version Format Type set to Fixed and the 
Version field included a space (for example, “1.0 “), the feature was created successfully. However, 
adding such features to a product later failed with the following error message:  

The version string "2.0  " for feature "TestSpaceInVersionField" is not a valid 
FlexNet version: must be <number>.<number> [Incident# 9379-0620915R]

To be able to map the feature to a product, producers had to return to the feature and modify the 
version to remove spaces, which caused frustration and wasted producers’ time.
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New Behavior

In the 2025.03 release, producers are alerted during the feature creation process that a feature with 
the Version Format Type set to Fixed cannot have a version number containing spaces. If a feature’s 
Version Format Type is set to Fixed and the Version field contains a space, upon saving the feature the 
following error message is displayed: 

The version format is invalid. Please follow the standard format and avoid any spaces. 

The following screenshot shows the Package Products | Create a Feature page with the red banner 
and the error message, because the version includes a space (“1.0 “):

Figure 32: The Package Products | Create a Feature page with the red banner and error message 

Rearranging Features on the Products Page in the Producer Portal
(SWM-22618)

On the Products page (under Products > Product > click a product name), features and feature 
bundles (on the Features tab) can now be sorted based on the date they were added to the product. By 
default, they are arranged in ascending order (the oldest feature or feature bundle is displayed at the 
top of the list). The order can be reversed by clicking the header of the Feature or Feature Bundle 
Name column.

The following screenshot shows the Feature or Feature Bundle Name column where the order of 
features can now be changed.
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Figure 33: On the Package Products | Create a Product page, the order of features can now be 
changed.

Note • When exporting feature information (using either .jar or Data Import template (.xlt) format), 
the feature to product linkage is reset to have the timestamp of the import.

Filter "Is remaining copies more than zero?" Now Working as Expected in 
Producer Portal
(Case 02905595, SWM-25218)

This release resolves an issue with the option Is remaining copies more than zero? that is available in 
the Advanced search panel on the List Entitlements page. In previous releases, regardless of whether 
the option was set to Yes or No, the List Entitlements page showed entitlements with copies greater 
than 0 as well as those with 0 copies. 

In the 2025.03 release, the option Is remaining copies more than zero? works as expected:

• Yes—The List Entitlements page shows only entitlements with copies greater than 0.

• No—The List Entitlements page shows only entitlements with 0 copies.

• None—The List Entitlements page shows entitlements with copies greater than 0 and those with 0 
copies.

The following screenshot shows the option Is remaining copies more than zero?:
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Figure 34: The Advanced search panel on the List Entitlements page

Note • A related known issue exists for entitlements for Embedded license models, see SWM-24042: 
Input Sanitization Disabled.

Resolved Discrepancy Between Number of Entitlements in End-User Portal 
and Producer Portal
(Cases 02979909, 02553109; SWM-24947, SWM-23317)

Previously, when the configuration option Show Line Items with Zero Copies by Default (under System 
> Configure > FlexNet Operations > General Options) is unselected, there was a discrepancy between 
the number of entitlements listed on the List Entitlements page in the Producer Portal and on the List 
Entitlements page in the End-User Portal. The reason was a synchronization issue, which meant that 
entitlements with an available quantity of zero were erroneously displayed on the List Entitlements 
page in the End-User Portal. 

This issue no longer occurs, and the List Entitlements page shows the correct number of entitlements 
in both portals. 



FlexNet Operations 2025.05 ALM Release Notes (UAT)  (May 2025)  67

Figure 35: The List Entitlements page in the Producer Portal shows entitlements with zero available 
quantity only when the configuration option Show Line Items with Zero Copies by Default is selected.

Figure 36: An example of the List Entitlements page in the End-User Portal showing entitlements with 
zero available quantity.

Export and Import Issues Resolved in 2025.03
The following issue related to the Data Export and Import functionality was resolved in the 2025.03 
release.

• Import/Export Jobs No Longer Getting Stuck on Job Server Restart

• Retriggering Stuck Jobs for Bulk Upgrade Operations

Import/Export Jobs No Longer Getting Stuck on Job Server Restart 
(Case 02874418, 02902735, 02909549; SWM-21535)

In previous releases, when an import/export job was running and at the same time the job server was  
restarted, the job was stuck in the "in Process" state and never completed until it was resubmitted.
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This behavior was problematic, because producers had to resubmit those stuck import/export jobs, 
which took up extra time. 

This has now been resolved. If an import/export job is in process while a job server restart occurs, that 
job will be moved to a waiting state so that the next run can pick it up. Producers no longer need to 
manually resubmit the hanging job.

Retriggering Stuck Jobs for Bulk Upgrade Operations
(Case 02969947, SWM-24096)

In the past, jobs for bulk upgrade operations could get stuck with the status “Submitted” or “In 
Progress”. There was no indication of whether the job was running. Restarting the job server had no 
impact on the job; it would remain stuck. The only solution for producers was to manually retrigger the 
job. 

This issue has now been resolved. If a job for a bulk upgrade operation gets stuck, restarting the job 
server triggers a new job which will pick up the work from the original job. This new job is scheduled to 
run within 2 minutes of the server restart.

Security Issues Resolved in 2025.03
The following issue related to FlexNet Operations security was addressed in the 2025.03 release.

Enforcing Account Access Permissions for Portal Users
(SWM-25459)

Previously, users with the Portal User role could access information that they are not entitled to see, by 
manipulating URL parameters.

In the 2025.03 release, it is no longer possible to access information without the necessary 
permissions, by manipulating URL parameters.

Issues Resolved in 2025.02
Issues in the following areas were resolved in the FlexNet Operations 2025.02 release:

• Entitlement Management Issues Resolved in 2025.02

• Security Issues Resolved in 2025.02

• User Experience Issues Resolved in 2025.02

Entitlement Management Issues Resolved in 2025.02
The following issues were resolved for entitlement management in the 2025.02 release.

• Restrict Activations on Expired Line Items for FlexNet Publisher Products

• Resolved Issue With Entitlement Emails
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Restrict Activations on Expired Line Items for FlexNet Publisher Products 
(Case 02144139, SWM-23877)

Previously, when an end user attempted to activate an expired FlexNet Publisher line item (using web 
services or the appactutil utility) and that line item had previously been activated on a client, the 
request erroneously succeeded. The reason for this behavior was that FlexNet Operations located the 
relevant fulfilment record and treated the activation as a reinstall. However, this behavior resulted in 
clients being able to continue using the software beyond the license expiration date.

To address this issue, FlexNet Operations now checks the line item expiration date before activation. If 
a line item has expired then the activation request is denied and an error message is shown. 

This change applies to all types of activations (online, offline, manually, or via web services). Other 
license lifecycle operations such as return, repair, or rehost are not affected.

Resolved Issue With Entitlement Emails
(Case 02988204, 02988951; SWM-25192)

A change introduced in the 2025.01 release caused an issue which meant that no entitlement emails 
could be sent to end users. When attempting to send an entitlement email, the following error was 
displayed: Tenant nnn does not have an associated publisher/identity. 

This issue has now been resolved, and entitlement emails are sent to end users.

Security Issues Resolved in 2025.02
The following issue related to FlexNet Operations security was addressed in the 2025.02 release.

Improved Error Handling for Status 500 Errors
(Case 2889182, SWM-22287)

Previously, status 500 errors could reveal the server hostname in the fault details of the response, 
which is considered a security risk. Such an error could be triggered by sending a bad request using 
web services—for example, by attempting to update a user with a typo in the request, like 
<urn:lastNam>?</urn:lastName>. 

This issue has now been addressed, and status 500 errors no longer reveal implementation details.

User Experience Issues Resolved in 2025.02
The following issues involving user experience were resolved in the 2025.02 release.

• Increased Download Speed in End-User Portal

• Updated Link to Customer Community

• Removed Truncation in End-User Portal on View Server Page

Increased Download Speed in End-User Portal
(Case 02776698, SWM-19906)
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In the End-User Portal, end users associated with several accounts can now download content more 
quickly. The syncing process has been optimized, allowing users to access downloads shortly after 
their accounts and entitlements are provisioned.

Updated Link to Customer Community
(SWM-24485)

Following the recent introduction of the new Revenera Community, the link Customer Community 
(available in the Producer Portal from the System menu) has been updated to point to the Community’s 
new URL, https://community.revenera.com. 

Any users attempting to access the previous URL, http://flexeracommunity.force.com/customer/, will 
be redirected to the new URL.

Removed Truncation in End-User Portal on View Server Page
(Case 02981114, SWM-24922)

Previously, the menu options available from the View menu on the View Server page in the End-User 
Portal were truncated on the left side of the screen and not readable. To access the View Server page, 
click Devices > Devices, then click the hyperlinked name or ID for a server (Cloud License Server 
instance or local license server). 

The following screenshot shows the fixed menu of the View Server page, with the menu options fully 
visible:

https://community.revenera.com
http://flexeracommunity.force.com/customer/
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Issues Resolved in 2025.01
Issues in the following areas were resolved in the FlexNet Operations 2025.01 release:

• Entitlement Management Issues Resolved in 2025.01

• User Experience Issues Resolved in 2025.01

Entitlement Management Issues Resolved in 2025.01
The following issues were resolved for entitlement management in the 2025.01 release.

• Request Button Now Triggering Renewal Email

• Entitlement Line Item Start or Expiry Updated Using "Change Start/Expiration Date" Button Now 
Reflected on CLS

• Confirmation Step No Longer Skipped During License Count Update

Request Button Now Triggering Renewal Email 
(Case 02890657, SWM-22556)

On the End-User Portal’s Expiring Entitlements page, end users can click a Request button to send an 
email message to the producer about their intent to renew selected entitlements. 

In previous releases, the End-User Portal failed to send such renewal emails. In the 2025.01 release, 
this issue has been resolved. When an end user clicks the Request button, the End-User Portal sends a 
renewal email to the email address specified in the configuration option Request Renewal Notification 
Email (under System > Configure > FlexNet Operations > Renewals). That email address is also used 
to populate the From field. The end user requesting the renewal will receive receive a copy of the 
renewal email, as their email address is included in the Cc field. 
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Important • Renewal emails are sent only if the following conditions are fulfilled:

• An email address is specified in the configuration option Request Renewal Notification Email 
(under System > Configure > FlexNet Operations > Renewals).  

• The email address specified in Request Renewal Notification Email has been verified in the 
Producer Portal on the Email/Domain Verification page (available from the Administer menu in 
the Email group). 

Entitlement Line Item Start or Expiry Updated Using "Change 
Start/Expiration Date" Button Now Reflected on CLS
(Case 02913332, SWM-24187) 

Previously, when an entitlement was mapped to a Cloud Licensing Service (CLS) instance and one of 
its line items had its start or expiration date changed using the Change Start/Expiration Date button on 
the Entitle Customers to Licenses | Create an Entitlement page (under Entitlements > List 
Entitlements by Order > click the entitlement’s hyperlinked ID), the new start or expiration date was 
not reflected on the CLS instance. This means that served clients' subsequent capability requests were 
not aligned with the new start or expiration date.

This issue no longer occurs. An entitlement line item’s changed start or expiration date is now 
immediately reflected on the mapped CLS instance, and can be viewed as follows:

• On the View Server page (Devices > Devices > click a hyperlinked device name > View > View 
Response) in the Capability Response section.

• Calling the /features endpoint.

Confirmation Step No Longer Skipped During License Count Update
(Case 02912962, SWM-24195)

Previously, when removing line items mapped to a local license server or a standalone device, FlexNet 
Operations was not enforcing the step where a confirmation of changes is needed before quantities on 
the device are updated, even though the configuration option Skip Confirmation or Skip Confirmation 
for Producer was unselected. 

The bug occurred when Generate Response was triggered on the View Server or Device page (under 
Devices > Devices > click hyperlinked name of a device), which changed the license status to License 
generated and decreased the license count on the device without waiting for the device to confirm the 
changes. This bypassed the expected Waiting for confirmation status, which should remain until the 
device explicitly sends a confirmation request.  

This has been fixed in the 2025.01 release. Clicking Generate Response now changes the license 
status to Waiting for confirmation. The license count is only updated on the device after it has sent a 
capability request to confirm the changes. 
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The following table shows the behavior and license status when a user clicks Generate Response after 
a license count change, depending on the selection of the Skip Confirmation and Skip Confirmation for 
Producer configuration options.

User Experience Issues Resolved in 2025.01
The following issue involving user experience was resolved in the 2025.01 release.

Configuration Changes Now Updated After Saving
(SWM-22817)

In previous releases, when changing a configuration setting under Embedded Devices (under System 
> Configure) and clicking Save Configs, the previous setting (either the previous value or 
selected/unselected state of the check box) was still shown. The updated setting was only visible after 
clicking Save Configs a second time. In addition, after saving changes, the confirmation message “The 
configuration was updated successfully” was formatted differently to other FlexNet Operations 
confirmation messages (using a white background instead of a blue banner). 

Both issues have been resolved in the 2025.01 release. Changes to configuration settings are now 
saved and visible after clicking Save Configs once, and the confirmation message is formatted as a 
blue banner. 

Known Issues
The following describes known issues in the current FlexNet Operations release.

Skip Confirmation
Skip Confirmation
for Producer Behavior in 2025.01

Unselected Unselected Status changes to Waiting for confirmation. Once a 
capability request is sent or uploaded, the status changes 
to License generated and the license count is updated on 
the device.

Selected Selected Status changes to License generated. Once a capability 
request is sent or uploaded in the Producer Portal and the 
End User Portal, the license count is updated on the 
device.

Selected Unselected Status changes to License generated. Once a capability 
request is sent or uploaded in the Producer Portal or the 
End User Portal, the license count is updated on the 
device.

Unselected Selected Status changes to License generated. Once a capability 
request is sent or uploaded in the Producer Portal (and 
optionally in the End User Portal), the license count is 
updated on the device.
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SWM-26718: Custom Logo Not Displayed in End-User Portal “View Server” 
or “Device” Page
In the End-User Portal, the Device or View Server page (available from the Devices menu) does not 
display a custom logo (if a custom logo has been specified). Instead, these pages display the Revenera 
logo and “FlexNet Operations” product name, as shown in this screenshot:  

Customers who experience this issue can contact Revenera support who can implement a workaround 
until the problem has been resolved.

Note • Producers can upload an image file to serve as custom logo in the End-User Portal using the 
Upload Company Logo configuration option (under System > Configure > End-User Portal Setup > 
Custom Branding). 

SWM-26045: Using Incorrect Country Codes in createUser API
Revenera identified an issue with the createUser API of the UserAcctHierarchyService web service 
that impacts users created without a supported country code. In such cases, the createUser API 
assigns a default country code, which results in incorrect data. These users are not synced with the 
Electronic Software Delivery (ESD) system and are therefore unable to access their software 
downloads in the End-User Portal.

For example, if "US" is the required country code and an unsupported variant like "USA" is provided, 
the API will successfully create the user but assign an incorrect default country code instead of "US." 
As this process does not return an error, customers may be unaware of the discrepancy. Consequently, 
the affected user is not properly synced with the ESD system and is unable to access downloads.
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To avoid interruptions in software delivery access, Revenera strongly recommends using only 
supported country codes when calling the createUser API.

SWM-23190: Analytics Menu and Configure Single Sign-On Page Not 
Accessible from Electronic Software Download Module Pages 
In the Producer Portal, when navigating to any page that is part of the Electronic Software Download 
module, the Analytics menu and the Configure Single Sign-On option (under the Administer menu) are 
no longer displayed and therefore cannot be accessed.

The Electronic Software Download module includes the areas Download Packages, Files, Agreements 
and Producers under the Products menu. 

As a temporary workaround, to access the Analytics menu, users should navigate away from an 
Electronic Software Download page (for example, by clicking Home in the navigation bar). The 
Analytics menu will become visible again and can be accessed. 

SWM-24928: Email Addresses for “File Created User Email” Missing in 
Software Delivery Download History Report  
In the Software Delivery Download History report (available from the Analytics menu), the File Details 
table is not displaying email addresses in the File Created User Email column due to an issue with the 
field size. As a workaround, the File Created User Email column is populated with the same email 
addresses as those displayed in the File Uploaded User Email column, because these email addresses 
typically are identical.  

SWM-24042: Input Sanitization Disabled
(Case 02889178) 

The FlexNet Operations 2024.12 release introduced limitations to the characters allowed in certain 
Producer Portal fields (see Security Issues Resolved in 2024.12). The following special characters 
were no longer allowed in a number of input fields to protect against injection attacks: 

[ : < > { } @ ; = \ , ! / | ? " # $ % ~ ^ ` ' ]

This functionality has now been disabled to allow further impact assessment. This means that the 
character restrictions placed on fields listed in Security Issues Resolved in 2024.12 are no longer in 
force.

SWM-23586: Hanging Bulk Operation Jobs Not Showing “Failed” Status
A fix made in the 2024.11 release (see description Import/Export Jobs Terminated Upon Job Server 
Restart) has been reverted for bulk operations. The fix remains in place for import/export jobs.

This means that any bulk operation jobs that hang when the job server is restarted are not terminated 
and are not automatically retriggered. 

SWM-19547: Download Search Page in End-User Portal Not Filtering Expired 
Accounts
In the End-User Portal, on the Download Search page (available from Downloads > Search Downloads), 
the Choose Account dropdown list does not filter out expired accounts. Instead, it erroneously displays 
expired and non-expired accounts. 

https://docs.revenera.com/fno2024/rn/Content/helplibrary/Export_and_Import_Issues_Resolved_in_2024_11.htm
https://docs.revenera.com/fno2024/rn/Content/helplibrary/Export_and_Import_Issues_Resolved_in_2024_11.htm
https://docs.revenera.com/fno2024/rn/Content/helplibrary/Security_Issues_Resolved_in_2024_12.htm
https://docs.revenera.com/fno2024/rn/Content/helplibrary/Security_Issues_Resolved_in_2024_12.htm
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Note • The Choose Account dropdown list is only displayed if the user belongs to more than one 
account that is entitled to downloads.

SWM-15171: Auto-Fulfill Failing During Large Bulk Upgrade Jobs
Auto-fulfill might fail in bulk upgrade jobs that contain more than 2200 line items.

SSRE-20257: Upload of Large File Images Failing 
The upload of file images that exceed 1 GB using HTTP upload fails. For large file images, Revenera 
recommends using FTP upload.

SWM-19052: Feature Count Aggregation Not Working As Expected
If a feature’s aggregation type is changed, the relevant instance of the Cloud Licensing Service might 
not update the aggregated feature counts according to the new aggregation type. 

However, if the entitlement for the product that contains the features is mapped to a new Cloud 
Licensing Service instance, the feature counts are aggregated correctly as per the new aggregation 
type. 

FNO-69836: Variables in Vendor String Causing License Activation Issues
License activation fails for product upgrades or normal license activation when the product to be 
upgraded or activated is associated with a feature that has a vendor string which contains substitution 
variables that are enclosed in double quotes (for example, 
"activationId":"{EntitlementLineItem.activationId}").

FNO-69338: Navigation in Package Products Pages Skipping Review 
Features Page
When the user navigates through the Package Products pages (under Products > Features) using the 
Next button at the bottom of each page, the Review Features and Review Feature Bundles pages are 
erroneously skipped. 

As a workaround, users who want to review the features and feature bundles that they just added can 
click the Review Features and Review Feature Bundles links, respectively, in the Packaging Guide 
section at the bottom of the page to access the Review Features page. 

SWM-15870: Mismatch Between User Name and Email Address Causing 
Issues with ESD (UserOrgHierarchyService)
When creating a user via the UserOrgHierarchyService web service (the predecessor of the User 
Account Hierarchy Service web service), it is possible to have different values for user name and email 
address. However, users whose user name and email address do not match cannot access downloads 
in the End-User Portal. 

Producers who use the UserOrgHierarchyService should use the methods from the User Account 
Hierarchy Service web service to avoid a mismatch between the user name and email address. 
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Note • The following changes have recently been made to the User Account Hierarchy Service web 
service:

• From the 2023.07 release onwards, it is not possible to create users with a mismatched user 
name and email address. See “createUser Operation in User Account Hierarchy Service Web 
Service No Longer Allows Mismatch Between User Name and Email Address” in the FlexNet 
Operations 2023 Release Notes.

• From the 2023.10 release onwards, users cannot update their email address to be different from 
their user name. See “updateUser Operation in User Account Hierarchy Service Web Service No 
Longer Allows Mismatch Between User Name and Email Address” in the FlexNet Operations 2023 
Release Notes.

FNO-69182: Incorrect Email Format Accepted When Creating User Via 
Import Template 
It is possible to create or update a user with an invalid email address format by importing user 
information using the Account and User import template (downloadable from Administer > Import 
Data Objects > Data Import Templates in the Producer Portal). Email addresses of the format abcd@ef 
(that is, an email address consisting of a recipient name, @ symbol and domain name but without top-
level domain) are erroneously accepted. 

FNO-68962: Invalid Characters in Device ID Causing Issues 
When the FlexNet Embedded toolkit creates a device ID that contains an invalid character, an error 
occurs.

The following control characters are not allowed in device names or the device ID:

^B ^D ^E ^G ^N ^O ^P ^Q ^R ^S ^T ^U ^W ^X ^Y ^[ ^\ ^] ^F ^C ^^ ^A ^V ^_ 

SWM-10701: Search Functionality in End-User Portal Erroneously Displays 
Download Link 
In the End-User Portal, users who should be denied access to a file based on their geographical 
location are able to display the download link for a restricted file when searching for the file name 
(using the Search function with the Files option on the Download Search page). However, users are not 
able to download the restricted file. 

FNO-66018: Errors in UI Updated for Download Package Selection Across 
Multiple Pages
In 2021.09, the Download Packages window was updated to allow package selection across multiple 
pages. The following errors currently exist for the updated UI.

• Incorrect error message for EULA license on Review & Resolve page

• Search string not properly clearing

• No option to return to full (unfiltered) Download Package list when “failed validation” message 
displays

• Failed validation error displayed for search results

https://docs.revenera.com/fno2023/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2023/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2023/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2023/rn/Content/helplibrary/fno_rn.htm
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• Pagination control fields not showing correct information

• Inappropriate message displayed for already downloaded packages

Incorrect error message for EULA license on Review & Resolve page

When you attempt to download packages that fail validation, the following message is displayed: 
“Some of the selected packages failed validation. You need to review and resolve the validation 
errors.” Then, on the Failed Packages window that is displayed if you click the “review and resolve” 
link in the message, the error for an unaccepted EULA incorrectly shows the following:

 “EULA has not been accepted. To accept EULA, click on the Download package ID.” 

Instead of “click on the Download Package ID”, the message should instruct the user to “...click ‘I 
Agree’”. 

Search string not properly clearing 

After you filter the package list on the Download Packages window, the message “Results for 
Download package name: <name>” is appropriately displayed. However, if you then click the Clear link 
at the end of message, the search string used to filter the package list remains, the list remains 
filtered (even if you move to the next page), and the “Results for the Download package name...” 
message is still displayed. You must manually delete the search string and click Search to clear the 
filter.

No option to return to full (unfiltered) Download Package list when “failed validation” 
message displays

If the “failed validation” message is displayed after you attempt to download packages from a filtered 
list on the Download Packages window, no mechanism exists to clear the filter to display all packages. 
You must manually delete the search field contents and click Search.

Failed validation error displayed for search results

After searching for and attempting to download a package containing an unaccepted EULA, the 
expected message “Some of the selected packages failed validation...” is displayed on the Download 
Packages window. However, if you then search for a package that does not contain an EULA (but do 
not attempt to download the package), you received the “failed validation” message instead of the 
correct message describing the filter results: “Results for Download package name: <name>”.

Pagination control fields not showing correct information

The pagination control fields on the Download Packages window are not displaying the correct totals 
for a filtered list of packages.

Inappropriate message displayed for already downloaded packages

When you select an entitlement line item whose packages have already been downloaded, the 
Download Packages window is displayed with incorrect message “Files sent for download. Please 
monitor the download manager pop up”. The message should be removed altogether or displayed only 
as package files are being sent to the Download Manager (before the actual Download Manager 
window is displayed).
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SWM-7952: Not All Applicable Download Links Available on “List 
Downloads” Page in End-User Portal
When end users are logged in with an activation ID for an entitlement line item that is associated with 
multiple products, the Downloads page (accessed from Downloads > List Downloads) in the End-User 
Portal does not always show links to all applicable product downloads.

SWM-7786: SHA2 Checksum Value of Previous File Shown
If a user has provided a file’s expected SHA2 checksum value for an upload and the file image is 
subsequently deleted, the Upload File page, when opened again, might show the SHA2 checksum 
value of the previously loaded file image.

FNO-65909: Download Files Not Visible For Self-registered And Trial Users
Download files might not be visible in the End-User Portal for self-registered users and those users 
registered through the “Try Before You Buy” registration.

FNO-61266: Translation Issues with Localization
Per a previous enhancement in 2020 R3 to add more language support for End-User Portal 
localization, certain strings—such as alerts and validation messages—are not being translated 
properly when localization is in effect. These issues will be addressed in an upcoming release.

Special Notes
This section contains special information pertaining to FlexNet Operations.

Plug-in Upgrade Needed for High-Speed File Uploads
If you intend to use the high-speed upload option to upload files, upgrade the Aspera plug-in to Aspera 
Connect 3.10.0 or later. 

Handling UI Conflicts When Using a Custom CSS for the End-User Portal
When you use your own CSS to customize the look of the End-User Portal, sometimes your custom CSS 
code conflicts with existing Revenera CSS code that is used to define certain buttons, pages, and other 
UI elements. When conflicts occur, handle each case individually, determining the basis of the conflict 
and adjusting the custom CSS as needed. If you require assistance, contact Revenera Technical 
Support (see Revenera Resources).

SOAP API Change Log
The following sections describe the changes that have been made to the FlexNet Operations SOAP API 
in the FlexNet Operations 2025 releases to date:

• Change Log for 2025.05

• Change Log for 2025.02
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Change Log for 2025.05
Zero Mapping of Activation IDs on Cloud License Servers 
(SWM-25022) 

The 2025.05 release introduces version 7 of the ManageDevice SOAP web service. The new version 
contains a new operation, zeroCountAddonLineItems, which enables producers to explicitly set an 
activation ID with a zero allocation mapping on a Cloud License Server (CLS) instance. 

To implement these new actions, the ManageDeviceService.wsdl file and its associated 
manageDeviceTypes.xsd file have been updated to v7 and modifications have been made. 

Note • This enhancement was tracked in SWM-25022. 

ManageDeviceService.wsdl

In addition to updating the version number from 6 to 7 in multiple locations in the 
ManageDeviceService.wsdl file, the following additional changes were made. Additions are 
highlighted.

# Change

1 <message name="decrementAddonLineItemsResponse">
<part name="msgparameters" element="tns:decrementAddonLineItemsResponse"/>

</message>
<message name="zeroCountAddonLineItemsRequest">

<part name="msgparameters" element="tns:zeroCountAddonLineItemsRequest"/>
</message>
<message name="zeroCountAddonLineItemsResponse">

<part name="msgparameters" element="tns:zeroCountAddonLineItemsResponse"/>
</message>

2 <operation name="incrementAddonLineItems">
<input message="tns:incrementAddonLineItemsRequest"/>
<output message="tns:incrementAddonLineItemsResponse"/>

</operation>
<operation name="zeroCountAddonLineItems">

<input message="tns:zeroCountAddonLineItemsRequest"/>
<output message="tns:zeroCountAddonLineItemsResponse"/>

</operation>
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manageDeviceTypes.xsd

In addition to updating the version number from 6 to 7 in multiple locations in the 
manageDeviceTypes.xsd file, the following Elements were added.

Change Log for 2025.02
Ability to List Fulfillment And License Information for Specified Host
The LicenseFulfillmentService.wsdl has been updated to v2. It includes the following:

• New getHostQuery operation to list fulfillment and license information by hostid. 

• New getHostCount operation to get the number of hosts that fit certain criteria. This number can 
be used as batchSize input in getHostQuery.

Note • These enhancements were tracked in SWM-22714 and SWM-25245, respectively (see 
Returning Fulfillment and License Information for Non-Embedded Technologies Using Web Services 
and New Operation for Getting Host Count in License Service SOAP Web Service). 

3 <operation name="incrementAddonLineItems">
<soap:operation style="document"/>
<input>

<soap:body use="literal" />
</input>
<output>

<soap:body use="literal" />
</output>

</operation>
<operation name="zeroCountAddonLineItems">

<soap:operation style="document"/>
<input>

<soap:body use="literal" />
</input>
<output>

<soap:body use="literal" />
</output>

</operation>

# Change

1 <xs:element name="incrementAddonLineItemsResponse" type="tns:linkAddonLineItemsResponseType"/>
<xs:element name="zeroCountAddonLineItemsRequest" type="tns:linkAddonLineItemsRequestType"/>
<xs:element name="zeroCountAddonLineItemsResponse" type="tns:linkAddonLineItemsResponseType"/>
<xs:element name="decrementAddonLineItemsRequest" type="tns:linkAddonLineItemsRequestType"/>
<xs:element name="decrementAddonLineItemsResponse" type="tns:linkAddonLineItemsResponseType"/>

# Change
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Changes to the WSDL and XSD Files

The LicenseFulfillmentService.wsdl file includes a reference to the licenseFulfillmentTypes.xsd file, 
and that .xsd file refers to the following additional .xsd files:

• licenseFulfillmentTypes.xsd

• trustedOfflineActivationTypes.xsd

• fulfillmentTypes.xsd

• commonTypes.xsd

LicenseFulfillmentService.wsdl

In addition to updating the version number from 1 to 2 in multiple locations in the 
LicenseFulfillmentService.wsdl file, the following additional changes were made. Additions are 
highlighted.

# Change

1 <message name="createLicenseResponse">
<part name="msgparameters" element="tns:createLicenseResponse"/>

</message>
<message name="createCVDFulfillmentsRequest">

<part name="msgparameters" element="tns:createCVDFulfillmentsRequest"/>
</message>
<message name="createCVDFulfillmentsResponse">

<part name="msgparameters" element="tns:createCVDFulfillmentsResponse"/>
</message>

2 <message name="createLicensesAsBatchAndConsolidateResponse">
<part name="msgparameters" element="tns:createLicensesAsBatchAndConsolidateResponse"/>

</message>
<message name="createCVDLicenseFileRequest">

<part name="msgparameters" element="tns:createCVDLicenseFileRequest"/>
</message>
<message name="createCVDLicenseFileResponse">

<part name="msgparameters" element="tns:createCVDLicenseFileResponse"/>
</message>

3 <message name="transferHostResponse">
<part name="msgparameters" element="tns:transferHostResponse"/>

</message>
<message name="getHostQueryRequest">

<part name="msgparameters" element="tns:getHostQueryRequest"/>
</message>
<message name="getHostQueryResponse">

<part name="msgparameters" element="tns:getHostQueryResponse"/>
</message>
<message name="getHostCountRequest">

<part name="msgparameters" element="tns:getHostCountRequest"/>
</message>
<message name="getHostCountResponse">

<part name="msgparameters" element="tns:getHostCountResponse"/>
</message>
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4 <operation name="createLicense">
<input message="tns:createLicenseRequest"/>

<output message="tns:createLicenseResponse"/>
</operation>
<operation name="createCVDFulfillments">

<input message="tns:createCVDFulfillmentsRequest"/>
<output message="tns:createCVDFulfillmentsResponse"/>

</operation>

5 <operation name="createLicensesAsBatchAndConsolidate">
<input message="tns:createLicensesAsBatchAndConsolidateRequest"/>
<output message="tns:createLicensesAsBatchAndConsolidateResponse"/>

</operation>
<operation name="createCVDLicenseFile">

<input message="tns:createCVDLicenseFileRequest"/>
<output message="tns:createCVDLicenseFileResponse"/>

</operation>

6 <operation name="transferHost">
<input message="tns:transferHostRequest"/>
<output message="tns:transferHostResponse"/>

</operation>
<operation name="getHostQuery">

<input message="tns:getHostQueryRequest"/>
<output message="tns:getHostQueryResponse"/>

</operation>
<operation name="getHostCount">

<input message="tns:getHostCountRequest"/>
<output message="tns:getHostCountResponse"/>

</operation>

7 <operation name="createLicense">
<soap:operation style="document"/>
<input>

<soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>
<operation name="createCVDFulfillments">

<soap:operation style="document"/>
<input>

<soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>

# Change
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licenseFulfillmentTypes.xsd

The only change made to the licenseFulfillmentTypes.xsd file between v1 and v2 was to update the 
version number from 1 to 2 in multiple locations in the file.

8  <operation name="createLicensesAsBatchAndConsolidate">
<soap:operation style="document"/>
<input>

<soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>
<operation name="createCVDLicenseFile">

<soap:operation style="document"/>
<input>

<soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>

9 <operation name="transferHost">
<soap:operation style="document"/>
<input>

<soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>
<operation name="getHostQuery">

<soap:operation style="document"/>
<input>

<soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>
<operation name="getHostCount">

<soap:operation style="document"/>
<input>

soap:body use="literal"/>
</input>
<output>

<soap:body use="literal"/>
</output>

</operation>

# Change
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trustedOfflineActivationTypes.xsd

The only change made to the trustedOfflineActivationTypes.xsd file between v1 and v2 was to 
update the version number from 1 to 2 in multiple locations in the file.

fulfillmentTypes.xsd

In addition to updating the version number from 1 to 2 in multiple locations in the 
fulfillmentTypes.xsd file, the following complexTypes were added.

# Change

1 <!-- START createCVDFulfillments -->
<xs:element name="createCVDFulfillmentsRequest" type="tns:createFulfillmentRequestType"/>
<xs:element name="createCVDFulfillmentsResponse" type="tns:createFulfillmentResponseType"/>
<!-- END createCVDFulfillments -->
<!-- START verifyCreateLicense -->
<xs:element name="verifyCreateLicenseRequest" type="tns:createFulfillmentRequestType"/>
<xs:element name="verifyCreateLicenseResponse" type="tns:createFulfillmentResponseType"/>
<!-- END verifyCreateLicense -->
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2 <!-- END consolidatedFulfillments -->
<!-- START createCVDLicenseFile -->
<xs:complexType name="createCVDLicenseFileRequestType">

<xs:sequence>
<xs:element name="queryParams" type="tns:CVDLicenseFileQueryParametersType" minOccurs="0"/>
<xs:element name="vendorStringIsCumulative" type="xs:boolean"/>
<xs:element name="pageNumber" type="xs:integer" nillable="true"/>
<xs:element name="batchSize" type="xs:integer" nillable="true"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="CVDLicenseFileQueryParametersType">

<xs:sequence>
<xs:element name="hostId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="nodeLockHostId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="customHostAttributes" type="tns:customAttributesQueryListType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="createCVDLicenseFileResponseType">

<xs:sequence>
<xs:element name="statusInfo" type="tns:StatusInfoType"/>
<xs:element name="responseData" type="tns:CVDLicenseFileConsolidatedResponseDataType" 

minOccurs="0"/>
</xs:sequence>

</xs:complexType>
<xs:complexType name="CVDLicenseFileConsolidatedResponseDataType">

<xs:sequence>
<xs:element name="licenseTechnology" type="tns:CVDLicenseFileConsolidatedLicenseDataType" 

minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>

</xs:complexType>
<xs:complexType name="CVDLicenseFileConsolidatedLicenseDataType">

<xs:sequence>
<xs:element name="licenseTechnologyName" type="xs:string" minOccurs="0"/>
<xs:element name="soldTo" type="xs:string"/>
<xs:element name="criteria" type="xs:string"/>
<xs:element name="licenseGenerator" type="tns:CVDLicenseGeneratorType" minOccurs="0" 

maxOccurs="unbounded"/>
<xs:element name="state" type="tns:StateType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="CVDLicenseGeneratorType">

<xs:sequence>
<xs:element name="licenseGeneratorName" type="xs:string"/>
<xs:element name="consolidatedLicenseId" type="xs:string"/>
<xs:element name="consolidatedFulfillments" type="tns:fulfillmentIdentifierListType"/>
<xs:element name="licenseFiles" type="tns:licenseFileDataListType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:element name="createCVDLicenseFileRequest" type="tns:createCVDLicenseFileRequestType"/>
<xs:element name="createCVDLicenseFileResponse" type="tns:createCVDLicenseFileResponseType"/>
<!--  END createCVDLicenseFile -->

# Change
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3 <!-- end transferHost -->
<!--START getHostQueryTypes -->
<xs:complexType name="hostDataType">

<xs:sequence>
<xs:element name="soldTo" type="xs:string"/>
<xs:element name="licenseTechnology" type="tns:licenseTechnologyIdentifierType" minOccurs="0"/>
<xs:element name="state" type="tns:StateType" minOccurs="0"/>
<xs:element name="hostID" type="xs:string" minOccurs="0"/>
<xs:element name="hostType" type="xs:string" minOccurs="0"/>
<xs:element name="account" type="xs:string" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="hostQueryParametersType">

<xs:sequence>
<xs:element name="hostId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="soldTo" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="licenseTechnology" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="hostType" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="account" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="fulfillmentState" type="tns:fulfillmentStateQueryType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="getHostQueryRequestType">

<xs:sequence>
<xs:element name="queryParams" type="tns:hostQueryParametersType" minOccurs="0"/>
<xs:element name="pageNumber" type="xs:integer" nillable="true"/>
<xs:element name="batchSize" type="xs:integer" nillable="true"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="getHostQueryResponseDataType">

<xs:sequence>
<xs:element name="hostData" type="tns:hostDataType" minOccurs="0" maxOccurs="unbounded"/>
<xs:element name="fulfillmentState" type="xs:string" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="getHostQueryResponseType">

<xs:sequence>
<xs:element name="statusInfo" type="tns:StatusInfoType"/>
<xs:element name="responseData" type="tns:getHostQueryResponseDataType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
<xs:element name="getHostQueryRequest" type="tns:getHostQueryRequestType"/>
<xs:element name="getHostQueryResponse" type="tns:getHostQueryResponseType"/>
<!-- END getHostQueryTypes -->

# Change
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commonTypes.xsd

In addition to updating the version number from 1 to 2 in multiple locations in the commonTypes.xsd 
file, the following additional changes were made. Additions are highlighted in blue.

# Change

1 <xs:simpleType name="CreateOrUpdateOperationType">
<xs:restriction base="xs:NMTOKEN">

<xs:enumeration value="CREATE_OR_UPDATE"/>
<xs:enumeration value="CREATE_OR_IGNORE"/>

</xs:restriction>
</xs:simpleType>
<xs:simpleType name="CreateOrUpdateOperationAccountType">

<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="CREATE_OR_UPDATE"/>
<xs:enumeration value="CREATE_OR_IGNORE"/>

</xs:restriction>
</xs:simpleType>
<xs:simpleType name="CollectionOperationType">

<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="REPLACE"/>
<xs:enumeration value="ADD"/>
<xs:enumeration value="DELETE"/>

</xs:restriction>
</xs:simpleType>
<xs:simpleType name="CollectionOperationAccountType">

<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="REPLACE"/>
<xs:enumeration value="ADD"/>
<xs:enumeration value="DELETE"/>

</xs:restriction>
</xs:simpleType>
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2 <xs:complexType name="OrgTypeList">
<xs:sequence>

<xs:element name="orgType" type="tns:OrgType" minOccurs="1" maxOccurs="unbounded" />
</xs:sequence>

</xs:complexType>

<xs:simpleType name="accountType">
<xs:restriction base="xs:NMTOKEN">

<xs:enumeration value="CUSTOMER"/>
<xs:enumeration value="PUBLISHER"/>
<xs:enumeration value="CHANNEL_PARTNER"/>
<xs:enumeration value="SELF_REGISTERED"/>

</xs:restriction>
</xs:simpleType>
<xs:complexType name="accountTypeList">

<xs:sequence>
<xs:element name="accountType" type="tns:accountType" minOccurs="1" maxOccurs="unbounded" />

</xs:sequence>
</xs:complexType>
<xs:complexType name="fulfillmentStateQueryType">

<xs:sequence>
<xs:element name="value" type="tns:fulfillmentStateType"/>
<xs:element name="searchType" type="tns:simpleSearchType"/>

</xs:sequence>
</xs:complexType>
<xs:simpleType name="fulfillmentStateType">

<xs:restriction base="xs:NMTOKEN">
<xs:enumeration value="ACTIVE"/>
<xs:enumeration value="OBSOLETE"/>
<xs:enumeration value="ON_HOLD"/>

</xs:restriction>
</xs:simpleType>

# Change
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Legal Information
Copyright Notice
Copyright © 2025 Flexera Software

This publication contains proprietary and confidential information and creative works owned by 
Flexera Software and its licensors, if any. Any use, copying, publication, distribution, display, 
modification, or transmission of such publication in whole or in part in any form or by any means 
without the prior express written permission of Flexera Software is strictly prohibited. Except where 
expressly provided by Flexera Software in writing, possession of this publication shall not be construed 
to confer any license or rights under any Flexera Software intellectual property rights, whether by 
estoppel, implication, or otherwise.

All copies of the technology and related information, if allowed by Flexera Software, must display this 
notice of copyright and ownership in full.

FlexNet Operations incorporates software developed by others and redistributed according to license 
agreements. Copyright notices and licenses for these external libraries are provided in a 
supplementary document that accompanies this one.

Intellectual Property
For a list of trademarks and patents that are owned by Flexera Software, see 
https://www.revenera.com/legal/intellectual-property.html. All other brand and product names 
mentioned in Flexera Software products, product documentation, and marketing materials are the 
trademarks and registered trademarks of their respective owners.

Restricted Rights Legend
The Software is commercial computer software. If the user or licensee of the Software is an agency, 
department, or other entity of the United States Government, the use, duplication, reproduction, 
release, modification, disclosure, or transfer of the Software, or any related documentation of any kind, 
including technical data and manuals, is restricted by a license agreement or by the terms of this 
Agreement in accordance with Federal Acquisition Regulation 12.212 for civilian purposes and 
Defense Federal Acquisition Regulation Supplement 227.7202 for military purposes. The Software was 
developed fully at private expense. All other use is prohibited.

https://www.revenera.com/legal/intellectual-property.html
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